
Brandenburgische Technische Universität Cottbus
Institut für Informatik, Informations- und Medientechnik
Lehrstuhl Grafische Systeme

Bachelorarbeit

Generierung eines 3D–Modells des
Branitzer Parks in VRML

Robert Moschner
Matrikelnr.: 2303053

25.01.2008

1. Betreuer: Prof. Dr. Winfried Kurth
2. Betreuer: Dr. Erwin Roth



Erklärung

Ich versichere, dass ich die vorliegende Arbeit selbstständig und ohne fremde Hilfe an-
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1 Einleitung

Geoinformationssysteme gewinnen im Bereich der Erzeugung von Geländemodellen im-
mer weiter an Bedeutung. Dreidimensionale Modelle machen Zusammenhänge sichtbar,
die in einer 2D–Ansicht nicht erfassbar sind. Diese Arbeit beschäftigt sich im Wesentli-
chen mit dem reinen Visualisierungsaspekt und der dreidimensionalen Darstellung von
Geländedaten. Dabei wird auf den Prozess der Erstellung der virtuellen Welten beson-
ders eingegangen.

Das Ziel der Arbeit ist es, aus bestimmten vorgegebenen geoinformationssystemgestütz-
ten Datensätzen virtuelle Welten des Branitzer Parks zu erstellen. Dabei wird auf Ma-
terial von Fernerkundungen und bereits bestehendem VRML–Material zurückgegriffen,
um realitätsnahe Modelle zu erzeugen. Damit Veränderung gezeigt werden können, sol-
len verschiedene Modelle des Branitzer Parks zu jeweils unterschiedlichen Zeitpunkten
erzeugt werden. Der Gestalungsschwerpunkt dieser virtuellen Welten liegt auf speziellen
Perspektiven, die Wandlungen zeigen und dem Betrachter Vergleiche zwischen verschied-
nen Zeitpunkten ermöglichen.

Für die Anforderungen an die fertigen virtuellen Welten reicht ein Geoinformations-
system aber nicht aus, weshalb auf eine 3D–Computergrafik Software zurückgegriffen
werden soll. Diese wird für die Zusammenfassung aller Daten zu einer virtuellen Welt
und für eine adäquate Darstellung dieser in VRML eingesetzt. Neben der Erstellung der
VRML-Welten ist es ein Teilziel dieser Arbeit, zu untersuchen, inwiefern das Geoinfor-
mationssystem ArcGIS geeignet ist, um die relevanten Daten für die VRML-Darstellung
zu erzeugen, und die Qualität der entstandenen VRML-Welten in Hinsicht auf bestimm-
te Gesichtspunkte zu bewerten.

Im Anschluss an dieses Kapitel wird auf die Aufgabenstellung (Kap. 2) eingegangen.
In Kapitel 3 folgen Ausführungen zum Branitzer Park und dessen Geschichte, und die
Motivation für einzelne Parkmodelle wird erläutert. Kapitel 4 geht auf VRML ein, und
Aspekte der Optimierung einer VRML-Welt werden beschrieben. In Kapitel 5 werden die
Grundlagen eines GIS, die unterschiedlichen Datentypen, sowie die verwendete Software
ArcGIS erklärt. Weiterhin werden die Relevanz einer 3D–Computergrafik Software und
das vorhandene Datenmaterial beschrieben. In Kapitel 6 wird auf die Überführung der
Rohdaten in ein Geländemodell eingegangen und die Erzeugung weiterer Daten in der
3D–Computergrafik Software erläutert. Die Zusammenführung aller erzeugten Daten zu
einer kompletten virtuellen Welt wird in Kapitel 7 beschrieben. Im letzten Kapitel (8)
erfolgt eine Bewertung der entstanden virtuellen Welten sowie des verwendeten Geoin-
formationssystems und Schlussfolgerungen werden gezogen.
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2 Aufgabenstellung

Im Rahmen des Projektes Virtueller Branitzer Park soll ein VRML-Modell des heu-
tigen Branitzer Parks erstellt werden, sowie mittels historischer Karten, Teilansichten
des Parks vor 150 Jahren, und ein Modell für zukünftige Bebauungsszenarien. Es liegen
Daten vor, die durch ein Laserscanning einer Überfliegung erhoben wurden, sowie histo-
risches und aktuelles Kartenmaterial. Darüber hinaus gibt es bereits erzeugte VRML-
Modelle von Teilen des Parks. Für die Bearbeitung und Erstellung der detaillierten
Modelle des Parks wird ein Geoinformationssystem zum Einsatz kommen. Im weiteren
Verlauf kommt ein 3D-Modeller, zum Nachbearbeiten und zur Erzeugung repräsentati-
ver Teile des Parks, zum Einsatz. Die Arbeit entstand im Rahmen einer Kooperation
des Lehrstuhls Grafische Systeme mit dem Systemhaus Stahr, Cottbus.
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3 Die Branitzer Parklandschaft

3.1 Einführung zum Branitzer Park

Die Branitzer Parklandschaft, nahe der Stadt Cottbus gelegen, gehört zu den bekann-
testen kulturgeschichtlichen und touristischen Attraktionen der Region. Cottbus befin-
det sich im südöstlichen Teils des Bundeslandes Brandenburg, das wiederum im Osten
Deutschlands liegt (Abb. 3.1). Cottbus hat heute ca. 102.0001 Einwohner und zählt
somit, als zweitgrößte Stadt des Bundeslandes, zu den Großstädten.

Abbildung 3.1: Die beiden Kartenausschnitte stellen die Lage von Cottbus und dem
Branitzer Park in Deutschland dar. Quelle: Google Earth

Der Branitzer Park ist nach dem Zonierungsprinzip2 angelegt, wodurch sich die ein-
zelnen Bereiche gestalterisch voneinander abgrenzen. Der Branitzer Park gliedert sich in
einen inneren Park und den sehr viel größeren Außenpark. Der innere Park hat eine Grö-
ße von ca. 100 Hektar und wird oft gemeint, wenn vom Branitzer Park gesprochen wird.
Zum inneren Park gehören neben den beiden Pyramiden im Westen auch die Gärtnerei
und die Schmiede im Osten. Das um 1770 erbaute Schloss, sowie die gegenüberliegenden
Gebäude, der Marstall und das Kavaliershaus, bilden dabei das Zentrum des Parks. Die
bekanntesten Teile des Parks sind der Pleasureground (Blumenpark) mit dem Schloss

1Stand 2007 Quelle: http://www.wikivoyage.org/de/Cottbus Besucht 17.12.2007
2Das Zonierungsprinzip beschreibt die Aufteilung eines Gebietes in mehrere Areale

8



und der Pyramidenground mit dem Tumulus (Wasserpyramide), der Landpyramide und
der ägyptischen Brücke. Wie bereits erwähnt, wird der innere Park von einem Außen-
park umgeben. Dieser gestaltet sich kranzartig um den inneren Park und hat eine Größe
von ca. 600 ha.

3.2 Geschichte des Parks

Der Branitzer Park hat eine belegte Geschichte, die über 550 Jahre zurück reicht. Hier
soll nur auf die Zeit von 1845 bis 1903 eingegangen werden. In dieser Zeit geschahen
die meisten baulichen sowie gestalterischen Veränderungen, die deshalb Anregungen zur
Erstellung historischer Parkmodelle sein können. Bei den Ausführungen zu den geschicht-
lichen Daten wird kein Anspruch auf Vollständigkeit erhoben.

Der Branitzer Park gilt als Alterssitz des Fürsten Hermann von Pückler-Muskau. Der
Fürst wollte mit dem Branitzer Park, seiner Hauptschöpfung, dem Muskauer Park, ein
ganz eigenes Werk hinzufügen. Pückler hatte in Branitz weniger gute natürliche Gege-
benheiten. Die Umgebung des geerbten Gutes gab wenig her, und das Schloss war in
vernachlässigtem Zustand. Die Wirtschaftsgebäude, sowie schlechte Stallungen unmit-
telbar am Wohnhaus, hatten mit einem schönen und bequemen Altersruhesitz, wie er
Pückler vorschwebte, wenig zu tun. Eine sandige, ebene Kiefernheide umgab das Anwe-
sen, und die Stadt Cottbus war als Silhouette am Horizont zu sehen. Er begann 1845 aus
einer ’Wüste’ in der ’märkischen Streusandbüchse’ eine ’Oase’ zu schaffen. [14, S. 6-7]

Pückler verkaufte im April 1845 die Standesherrschaft Muskau. Im August des glei-
chen Jahres begannen in Branitz erste Kauf- und Tauschverhandlungen mit den Bauern,
die ihre Höfe beiderseits des Dorfteiches, heutiger Schwarzer See, hatten. Ab 1846, nach
Aufenthalten des Fürsten in Thüringen, Babelsberg und Italien, begann Pückler mit der
Gestaltung des Parks. Drei Parkpläne wurden in dieser Zeit erstellt und ein 13 Hektar
umfassendes Areal gestaltet. Der vorhandene Schlossgraben wurde teilweise zugeschüt-
tet. Im April 1847 kam der Dresdner Baumeister auf Einladung Pücklers, Gottfried
Semper nach Branitz und fertigte mehrere Zeichnungen an. Zu dieser Zeit wurde eine
Fläche von 40 Hektar, im Mittelpunkt das Schloss, bearbeitet. Größere Erdumschich-
tungen sowie Aushebungen begannen. 1847 bis 1848 erfolgten wichtige Eingriffe an der
heutigen Pergola, sowie Arbeiten am ursprünglichen Wirtschaftsgebäude, dem heutigen
Marstall, das nach dem Vorbild der Tudorgotik umgestaltet wurde. Es diente damals als
Stall, Wagenremise und Wohnraum. 1850 erhielt das Schloss durch Aufschüttung eine
Terasse. 1847 bis 1851 wurde das Parkinspektorenhaus, heutiges Torhaus, umgebaut.
1848 bis 1850 wurde das Blaue Haus, das Ananashaus und das Treibhaus der Schloss-
gärtnerei errichtet. 1849 bis 1851 entstand die Parkschmiede im Tudorstil und diente
neben der wirtschaftlichen Nutzung auch als Wohn- und Torwächterhaus. Sie bildete
den Haupteingang zu Park und Schloss Branitz. Bis 1850 wurden etwa 400 große Bäume
gepflanzt, wovon 20 Prozent wieder eingingen und ersetzt werden mussten. Die ersten
Arbeiten gelangten zu einem Abschluss, und die Familie Pückler nahm Branitz als ständi-
gen Wohnsitz. 1853 hat der Park eine gestaltete Fläche von 38 Hektar. Von 1855 bis 1857
wurden der Pyramidensee ausgehoben, der Tumulus aufgeschüttet und die Wasserfläche
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am Schloss mit dem Schilfsee verbunden. Zwischen 1857 und 1860 fanden umfangrei-
che Veränderung am Schloss statt, das Torhaus am Muskauer Weg wurde erbaut und
das Parisol errichtet. Die Aufschüttung der Landpyramide begann und wurde 1862 ab-
geschlossen. Ursprünglich war sie als Stufenpyramide angelegt und zur Begräbnisstätte
für die Fürstin Pückler bestimmt. 1864 bis 1867 wurde die ägyptische Brücke am Fuße
der Landpyramide errichtet. 1868 begannen die Arbeiten am hinteren Schlangensee und
dem Hermannsberg, der höchsten Erhebung im Branitzer Park. Am 4. Februar 1871
stirbt Fürst Pückler-Muskau auf Branitz. Den Branitzer Park erbte sein Vetter, Her-
mann Victor Sylvius Albrecht Ludwig Heinrich Graf von Pückler (1835-1897). 1877 bis
1882 wurden verstärkt Instandsetzungsarbeiten und bauliche Veränderungen vorgenom-
men. 1879 pflanzte Parkinspektor Bleyer, überwiegend Kiefern auf dem Hermannsberg,
sowie Weymouthkiefern und Fichten an verschieden Stellen im Park. 1871 bis 1890 fan-
den Eingriffe im Gelände der Gärtnerei statt, wie der Abriss des Blumensalons und des
Vermehrungshauses. Mit dem Tode Graf Heinrichs (1897) war der Park nunmehr fast
vollendet. 1903 wurde ein Parkplan angefertigt. Zu dieser Zeit umfasste der Branitzer
Park ca. 650 Hektar. [5, S. 37-43]

3.3 Der Branitzer Park als virtuell begehbares Modell

3.3.1 Das virtuelle Modell ”Branitzer Park” und die Sichtachsen

Der Branitzer Park wurde, vom Systemhaus Stahr in Zusammenarbeit mit der Stiftung
des Branitzer Parks, schon als VRML-Modell realisiert. Die Bereiche der Pyramiden bis
hin zum Hermannsberg und der Bereich des Schlosses mit Marstall und Kavalierhaus sind
bereits modelliert. Als Grundlage für die Erzeugung dieser Modelle diente eine CAD3-
Karte, anhand derer die beiden Szenarien mit Hilfe einer 3D-Computergrafik Software
manuell ”nachgebaut” wurden. Es fand hier nur eine Annäherung an das reale Abbild
des Parks statt, und somit stellt es kein an der Realität exakt orientiertes, virtuelles
Modell dar. Weiterhin ist die Vegetation, die eine wichtige Rolle für den Park spielt,
in ihrer Darstellung nur exemplarisch angedeutet. Die bereits bestehenden Gebäude,
wie beispielsweise das Schloss und umliegende Bebauung, sind hingegen sehr detailreich
modelliert und lassen sich mit dem Original gut vereinbaren. In dieser Arbeit werden
Teile übernommen und in das Ergebnis einfließen. Die Grundlage für eine weiterführende
Arbeit ist zusätzliches Datenmaterial, mit dem es möglich ist, ein Modell mit größerer
Genauigkeit zu erstellen. Material aus Fernerkundungen, das die exakte Bestimmung der
Oberflächenform ermöglicht, sowie Karten, die die Standpunkte von Bäumen und Ge-
bäuden definieren, bilden dabei das Fundament. Benötigtes, schon modelliertes Material,
wie die Gebäude, wird in die Arbeit übernommen und gegebenenfalls modifiziert. Einen
wichtigen Anhaltspunkt für die Gestaltung des Modells bilden Sichtachsen, die Pückler
zu seiner Zeit bewusst in den Park eingearbeitet hat. Sie sollen bei der Erstellung und
Platzierung von Objekten und Bäume im Modell, besonders berücksichtigt werden. Das
virtuell begehbare Modell soll einen Eindruck des heutigen Parks vermitteln, aus dem

3CAD steht für Computer Aided Design und meint das computergestützte Konstruieren
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auch Vergleiche zu historischen und zukünftigen Modellen möglich sind.

3.3.2 Motivation für historische Parkmodelle

Unter dem Aspekt, Einblicke zu geben, wie der Park zu Pücklers Lebzeiten aussah, kön-
nen Szenarien erstellt werden, die das Aussehen des gesamten Parks oder von Teilen des
Parks, vor und während der Entstehung widerspiegeln. Im Vordergrund stehen prägnan-
te Veränderungen des Geländes mit seinen Wegen, Gewässern und Bäumen. Desweiteren
sind Veränderungen an Gebäuden nicht irrelevant und werden in die Erzeugung mit ein-
bezogen. Die Erstellung eines Szenarios stützt sich auf die detaillierte Beschreibung der
Parkgeschichte zwischen 1845-1903 (Kap. 3.2), in der häufig Veränderungen am Park
vorgenommen wurden. In dieser Zeit vollzog sich eine rasante Entwicklung, da die Ver-
änderung der Landschaft, der Gebäude, der Vegetation und der Ausdehnung des Parks
schnell voranschritt. Innerhalb von ca. 60 Jahren wuchs der Park von 13 Hektar auf 650
Hektar an.

Dies begründet sich einerseits darin, dass Pückler unter gewissen Druck stand, da er
selber schon 60 Jahre alt war, als er den Park übernahm, in dem er seinen Altersruhesitz
sah. Anderseits hatte Pückler durch einen Vertrag mit dem städtischen Gefängnis bis zu
130 Arbeiter zur Verfügung, was ihm half, seine Pläne in kürzester Zeit umzusetzen. [5,
S. 41]

Es sollen aus vorhandenem Kartenmaterial, Bildern und Vermessungsdaten, Modelle
und damit Sichten zu ausgewählten Zeiten rekonstruiert werden. Von besonderem Inter-
esse sind Szenarien, die sich überwiegend auf vorhandenes Material stützen, um mög-
lichst ein annähernd reales, nachvollziehbares Modell zu erhalten. Hierbei besteht kein
Anspruch auf vollständige historische Korrektheit der entstehenden Modelle, es sollen
vielmehr Einblicke gegeben werden, wie es hätte aussehen können. Relevante Fakten, die
nicht oder nur teilweise überliefert sind, die aber zur Erzeugung eines aussagekräftigen
Szenarios nötig wären, werden nach bestem Wissen und Gewissen ergänzt.

3.3.3 Motivation für fiktive Parkmodelle

Der Außenpark diente zu Lebzeiten des Fürsten Pückler als Einstimmung auf den inne-
ren Park sowie als wichtiger wirtschaftlicher Faktor für den gesamten Branitzer Park.
Um die Wirtschaftlichkeit zu sichern, und dennoch gestalterisch mit dem inneren Park
zu harmonieren, wurde durch den Fürsten Pückler-Muskau der Außenpark im Sinne ei-
ner Ornamental Farm4 gestaltet und betrieben. Für das Parkerlebnis waren diese land-
wirtschaftlich genutzten Flächen von großer Bedeutung. Der Fürst hatte seinerzeit eine
Trennung in Innen- und Außenpark, wie es heute der Fall ist, nicht angestrebt. Seine In-
tention war, das gesamte Areal gärtnerisch zu gestalten. Er hatte die Absicht eine Route
anzulegen, die eine Umfahrung des kompletten Parks ermöglicht, und von der Blicke
in den Park, aber auch hinaus möglich sind, ohne die Grenzen zu erahnen. [5] Ettrich
schreibt: ”Die schönsten Punkte entlang dieser Routen sind häufig mit der ’Lebensreise’

4ausgeschmückte Landwirtschaft
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des Fürsten Pückler verknüpft. Bild- und Bauwerke, Bäume und Seen, Inseln und We-
ge, Lichter und Schatten, Farbe und Raum offenbaren das Streben nach der Einheit der
Künste und dem Traum vom Gesamtkunstwerk.” [5, S. 6]

Nach dem Tode des Fürsten und nach den Entwicklungen ab 1945, die mit der Enteig-
nung, der Ansiedlung von Neubauern und der anschließenden Kollektivierung der Land-
wirtschaft verbunden waren, verlor der Außenpark zunehmend seine gestalterischen Kon-
turen. Das von Pückler angestrebte Gesamtkunstwerk konnte immer weniger als solches
wahrgenommen werden, da der Zusammenhang zwischen Außen- und Innenpark immer
undeutlicher wurde. Als Folge dieser Entwicklung verschwanden mehr und mehr Sich-
ten, die Pückler ursprünglich gezielt eingesetzt und seinen Park nach diesen entworfen
und angelegt hatte. Weiterhin sind große Teile des Pücklerschen Parkareals durch berg-
baubedingte Grundwasserabsenkungen beeinträchtigt worden. Durch intensive landwirt-
schaftliche Nutzung gingen kleinteilige Strukturen verloren, und zahlreiche Zweckbauten
wurden errichtet. Diese werden als Störung des Gesamtensembles wahrgenommen. [13]

Heutige Maßnahmen der Stiftung Fürst-Pückler-Museum beschäftigen sich mit der
Erhaltung und Wiedergewinnung des Gesamtkunstwerkes Branitzer Park- und Kultur-
landschaft und, damit verbunden, mit der Wiederherstellung der Sichten. [13, S. 24] Von
weiterem Interesse ist die Entwicklung in der näheren Umgebung, aber auch die Entwick-
lung des Branitzer Parks selbst, um Aussagen über eventuell entstehende, unerwünschte
Sichten zu treffen und gegebenenfalls diesbezügliche Veränderungen im Vorfeld zu un-
terbinden. Teilziel dieser Arbeit ist es, Sichten zu generieren, die Szenarien andeuten
sollen, unter der Annahme, dass geplante Bauvorhaben durchgeführt werden oder auch
natürliche Phänomene, wie beispielsweise die Absenkung des Wasserspiegels oder das
Absterben von Bäumen, bedingt durch einen Klimawandel, auftreten. Es gilt zu unter-
suchen, inwiefern sich Sichten von verschiedenen Standpunkten im Vergleich zu heute
verändern. Es soll sich hierbei so nah wie möglich an der Realität orientiert werden, um
möglichst genaue Szenarien zu erzeugen.
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4 VRML

4.1 Einführung

Zur Realisierung des Branitzer Parks als virtuell begehbares Modell bedarf es einer Mög-
lichkeit der Darstellung. Als Plattform zur Repräsentation der generierten Szenen soll
VRML dienen. Hase schreibt: ”VRML (Virtual Reality Modeling Language) ist im we-
sentlichen ein Dateiformat zur Beschreibung von Objekten im Raum. Diese Objekte kön-
nen außer dreidimensionalen geometrischen Strukturen auch eine Reihe anderer Dinge
enthalten, und zwar alles, was man zur Beschreibung dreidimensionaler Welten oder
Szenen benötigt; hierzu gehören zum Beispiel auch Bilder und Töne.” [6, S. 9] Mittels
VRML ist es dem Anwender möglich, durch virtuelle Welten zu navigieren und mit Ob-
jekten zu interagieren. Virtuelle Welten werden in VRML mittels Objekten beschrieben.
Diese Objekte werden Knoten genannt und sind die Grundbausteine einer VRML-Datei.
Knoten können beliebige Inhalte speichern, wie beispielsweise Transformationen, Mate-
rialeigenschaften, Geometrieeigenschaften uvm. Eine komplette Übersicht der Knoten ist
in [11, S. 74-84] zu finden. VRML erlebte 1994 seine Geburtsstunde. Es wurde entwickelt
mit dem Ziel, eine dreidimensionale Schnittstelle für das World Wide Web (WWW) zu
schaffen. [11, S. 7-9] VRML besitzt nach Daessler [12, S. 111]

• Geometrische Primitive (Kegel, Kugel, Zylinder)

• Licht-, Material-, Textur-, Videosteuerung

• Räumliche Klänge

• Animationen

• Kollisionserkennung durch Verkörperung des Betrachters

• Hyperlinks, Aussichtspunkte, Navigationsarten

• Prototyping zur Spracherweiterung

• Verschiedene Skriptsprachen für die Implementierung einer Szenenlogik

• Ergebnisbehandlung und Ereignisweiterleitung

VRML gleicht herkömmlichen Programmiersprachen nicht. Der Quelltext wird im ASCII-
Format geschrieben und nicht compiliert, um ihn auszuführen, sondern vom darstel-
lenden Rechner abgearbeitet und direkt wiedergegeben. [6, S. 2] Um VRML-Szenen
zu betrachten, bedarf es eines VRML-Browsers. Dieser muss die Fähigkeit besitzen,
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VRML-Quellen zu parsen und als dreidimensionale Szene darstellen zu können. Je nach
Ausführung ist dieser Browser entweder ein eigenständiges Programm, das ohne einen
WWW-Browser auskommt, oder eine durch ein Plugin integrierte Lösung. Es gibt ei-
ne Vielzahl von VRML-Browsern als Plugin oder Standalone1. Ausschlaggebend für die
Wahl eines VRML-Browsers zur Darstellung der generierten Szenen sind Stabilität, kor-
rekte Darstellung der Szenen und eine gute Navigierbarkeit. Für die Arbeit kommt der
VRML-Browser BS Contact V. 7.039 der Firma Bitmanagment Software GmbH zum
Einsatz. Der Browser bietet die Möglichkeit, VRML-Welten im WWW-Browser oder in
einem eigenständigen Fenster zu betrachten.

4.2 Überlegungen zu Performance und Qualität der
VRML-Welten

VRML wird für dieses Projekt genutzt, da es auf jedem Computer lauffähig ist und keiner
großen Vorbereitungen durch den Benutzer bedarf. Grundvoraussetzung, neben einem
Computer, ist der VRML-Browser. Da von realen Gegebenheiten ausgegangen wird, in
der Kapazitäten beschränkt sind, ist es nötig, im Vorfeld zu klären, welche Ausmaße eine
Szenerie annehmen kann, um komplexe Inhalte dennoch adäquat darstellen zu können.
Zu den ausschlaggebenden Faktoren für die Qualität der Darstellung und Benutzbar-
keit zählt zum einen die benutzte Hardware und gegebenenfalls die Geschwindigkeit des
Internetzugangs. Zum anderen ist die Größe und Komplexität der VRML-Welt maßgeb-
lich für die Performance. Da kein Einfluss auf verwendete Hardware genommen werden
kann, soll sie für weitere Überlegungen außer acht gelassen werden. Der Ansatz, um ei-
ne gewisse Leistung und Stabilität zu gewährleisten, besteht darin, die Optimierung an
den VRML-Szenen vorzunehmen. Ein Aspekt, der dazu beitragen soll, ist die einfache
Editierbarkeit durch einen elementaren Aufbau der Szene. Das heißt, dass es jeder Zeit
möglich sein soll, kleinste Veränderung vornehmen zu können, ohne komplette Quelltex-
te zu durchsuchen. Einzelne Modelle werden als eigenständige Objekte in die komplette
VRML-Welt integriert und können auch außerhalb des Zusammenhanges einer Szene be-
trachtet werden. Weiterhin gilt es zu ermitteln, welche Faktoren einer VRML-Szene lange
Ladezeiten verursachen, oder die Navigation durch die virtuellen Welten beeinträchtigen.
Möglichkeiten zur Reduzierung der Daten und die damit verbundene Performancestei-
gerung sollen im Folgenden beschrieben werden. Die Ausführungen sind Auszüge und
stützen sich auf Chen [2, S. 84-85].

Strukturierung der Modelle

Einzelne Objekte, die nicht aus geometrischen Primitiven bestehen, sind in VRML durch
IndexedFaceSets2 beschrieben. Szenen mit einer großen Anzahl von IndexedFaceSets ver-
langsamen den Browser. Wenn diese Einzelobjekte zu einem Objekt zusammengefasst
werden, erhöht sich die Geschwindigkeit drastisch. Desweiteren sollte in der VRML-Datei

1für sich allein ausführbares Programm
2IndexedFaceSets definieren eine Menge von Polygonflächen
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das Backface Culling3 aktiviert werden, wann immer möglich. Dies kann die Renderzeit
um die Hälfte verkürzen.

Szenen-Komplexität

Die Komplexität einer Szene, in Abhängigkeit vom Betrachterstandpunkt, kann mit dem
Level of Detail-Knoten (LOD) reduziert werden. Nicht immer ist es nötig, ein Objekt in
all seinen Einzelheiten zu sehen, wenn man sich weit entfernt hat. Mit dem LOD-Knoten
kann bestimmt werden, ab welcher Entfernung komplexe Objekte durch vereinfachte er-
setzt werden. Um den Effekt eines plötzlich aus dem Nichts entstehenden Objekts zu
umgehen, muss ein gewisser Raum zwischen den einzelnen Objekten bestehen. Deshalb
kommt das Prinzip des LOD oft nur in weit geöffneten Räumen zur Anwendung.

Räumliche Organisation

Die meisten Browser rendern komplette Gruppen- und Transformationsknoten gleich-
zeitig, um die Geschwindigkeit des Renderns zu erhöhen. Sind zwei Objekte gruppiert,
die räumlich stark separiert sind, reduziert das die Möglichkeit des Browsers, zu entschei-
den, welche Gebiete gerendert werden müssen. Beide Objekte werden immer gerendert,
sobald eines von beiden innerhalb des Sichtkegels des Anwenders ist. Daher sollte schon
im Vorfeld darauf geachtet werden, welche Objekte gruppiert werden. Desweiteren ist es
bei räumlich weit ausgedehnten Objekten, wie einem Terrain, sinnvoll, die Geometrie in
einzelne räumlich kompakte Cluster zu unterteilen, wenn der Benutzer immer nur einen
kleinen Teil der Szenerie betrachtet. Das IndexedFaceSet wird in mehrere unterteilt. Das
ermöglicht dem Browser, Bereiche auszusondern, die nicht im Sichtfeld des Betrachters
sind, was sich in einer Steigerung der Performance widerspiegelt.

Instanzierung

Die Instanzierung einzelner Objekte ist eine weitere Möglichkeit, die Performance ei-
ner VRML-Welt zu erhöhen. VRML hat dafür die ’DEF’- und ’USE’-Befehle. Schon
einmal benutze Geometrie kann somit beliebig oft instanziert werden. Der Vorteil be-
steht darin, dass der Overhead einer Datei drastisch reduziert werden kann, was sich
auch auf die Leistung auswirkt. Der Nachteil dabei besteht darin, dass jedes instanzierte
Objekt ein Abbild vom Original ist, das heißt, wird das Original verändert, verändern
sich auch alle Instanzen. Für Knoten, die auf das Dateisystem zugreifen müssen, um
beispielsweise Bilder zu laden, reduziert sich die Ladezeit signifikant.

3Der Begriff Backface Culling bezeichnet eine Technik der 3D-Computergrafik, mit der ein Großteil von
nicht sichtbaren Dreiecken einer Szene eliminiert werden kann, um so die Darstellungsgeschwindigkeit
zu erhöhen.
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Texturen oder Polygone

Texturen können komplexe Geometrie ersetzen. Dabei sollten verwendete Texturen mög-
lichst wenig Speicher belegen und wenig transparente Bereiche besitzen, um maximale
Leistung sicherzustellen. Sie sollten an den Stellen eingesetzt werden, an denen die Rea-
lisierung eines Objektes, aufgrund der Detailliertheit mittels Polygonen, zu aufwändig
wäre.
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5 Software & Datengrundlagen

5.1 Geoinformationssysteme

Ein Geoinformationssystem, kurz GIS, ist ein Informationssystem für raumbezogene Da-
ten. Es erfasst und verarbeitet Objekte und deren Beziehung zu anderen Objekten der
realen Welt. Eine grundlegende Definitionen für GIS gibt es in der Forschungswelt nicht,
daher sei an dieser Stelle auf Bill verwiesen. ”Ein Geographisches Informationssystem ist
ein rechnergestütztes System, das aus Hardware, Software, Daten und Anwendungen be-
steht. Mit ihm können raumbezogene Daten digital erfasst und redigiert, gespeichert und
reorganisiert, modelliert, und analysiert sowie alphanumerisch und graphisch präsentiert
werden.” [1, S. 5]

Räumliche Daten werden in einer Datenbank gespeichert und organisiert. Dies erlaubt
einen schnellen sowie sicheren Zugriff und garantiert zügige Abfragen für Analyse- und
Auswertungszwecke. Die Anfänge der GIS liegen in den 60er Jahren, als man begann,
die geografische Beschaffenheit der Erde mittels Computerdatenbanken darzustellen und
zu visualisieren. [8, Seite 6] Ab den 80er Jahren wuchs dieser Markt drastisch, als das
große Potential erkannt, und unabkömmlich für Wirtschaft, Regierung und Forschung
in vielerlei Anwendungsgebieten wurde. [4, Abschnitt 1-2] Heute werden nach Liebig [9,
Seite 3] GIS u.a. in den folgenden Bereichen eingesetzt:

• Umweltschutz (Biotop- und Nutzungstypen, Altlastenkataster, Nationalpark)

• Notdienste (Polizei, Feuerwehr, Rettungswesen)

• Stadt- und Raumplanung (Deponiestandorte, Kanalnetze)

• Versorgungsunternehmen (Strom, Wasser, Gas, Kommunikation)

• Land- und Forstwirtschaft

• Wissenschaft und Technik (Geologie, Geographie, Biologie, Hydrografie 1, Berg-
bau)

• Fachhochschulen, Universitäten, Software- und Hardwarefirmen (Informatik, Ma-
thematik)

1Hydrografie oder auch geografische Gewässerkunde bezeichnet die Lehre von Erscheinungsformen,
Eigenschaften, Vorkommen, Verbreitung und Haushalt des Wassers in Verbindung mit der Erdober-
fläche.
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5.2 Aufbau und Funktionsweise von ArcGIS

5.2.1 ArcGIS-Anwendungen

In dieser Arbeit geht es vornehmlich um die Realisierung und Präsentation dreidimen-
sionaler Daten. Deshalb soll in diesem Kapitel näher auf ausgewählte Bestandteile der
ArcGIS-Produktfamilie eingegangen werden, da diese einen Kernpunkt darstellen. Un-
ter dem Aspekt, Möglichkeiten zu diskutieren, adäquate 3D-Modelle zu erzeugen und
einen großen Teil dieses Prozesses in einem GIS zu realisieren, ist es notwendig, genauer
auf das Verwendete einzugehen. Die folgenden Ausführungen stützen sich hauptsächlich
auf die Hilfe von ArcGIS, solange nicht anders vermerkt. Für diese Arbeit wurde das
Softwarepaket ArcGIS von ESRI2 zur Verfügung gestellt, mit dem es möglich ist, Daten
zu erfassen, zu verwalten, zu strukturieren, zu analysieren und zu visualisieren. ArcGIS
ist der Sammelbegriff für eine umfassende GIS-Produktfamilie, die aus sich ergänzenden
GIS-Software-Produkten besteht. Es ist in verschiedene Module gegliedert, die unabhän-
gig voneinander genutzt werden können. ArcGIS wurde von ESRI entwickelt und wird
stetig weiterentwickelt.

Als Grundvoraussetzung zur Erstellung, Bearbeitung oder Aufbereitung von raumbe-
zogenen Daten dient das Modul ArcGIS Desktop. ArcGIS Desktop setzt sich wiederum
aus den Anwendungen ArcMap und ArcCatalog zusammen.

ArcMap ArcMap ist eine kompakte Anwendung, mit der Geodaten erstellt, ausgewer-
tet und präsentiert werden können. Es stellt die zentralen Funktionen wie das Editieren,
Analysieren und Erstellung von Karten aus raumbezogenen Daten zur Verfügung. Arc-
Map kennt generell zwei verschiedene Ansichten:

• Die Datenansicht ist eine Umgebung, in der raumbezogene Daten als Layer sym-
bolisiert sind. Diese können analysiert und zu gewünschten Sichten zusammenge-
stellt werden. Ein Inhaltsverzeichnis strukturiert Anzeige und Zugriff auf die Dar-
stellungseigenschaften. Die Datenansicht liefert einen Blick auf einen Ausschnitt
beliebiger GIS-Daten.

• Die Layoutansicht ist eine dem Seitenlayout einer Karte entsprechende Ansicht mit
zusätzlichen kartografischen Elementen wie: dem Maßstabsbalken, einem Nordpfeil
oder Übersichtskarten, Legenden, Planstempel, etc. Diese Ansicht dient für die
Anordnung aller zur Ausgabe vorgesehenen Elemente im Layout. Es handelt sich
um eine Vorbereitung für die Ausgabe in Druckform oder als Grafik.

ArcCatalog ArcCatalog ist eine Managementoberfläche, in der alle Daten und Doku-
mente verwaltet werden. Es wird dann eingesetzt, wenn Daten erstellt, gesucht, struk-

2ESRI (Environmental Systems Research Institute) mit Sitz in Redlands, Kalifornien (USA), ist die
weltweit erfolgreichste Firmengruppe auf dem Gebiet der Geografischen Informationssysteme (GIS)
und in mehr als 90 Ländern der Erde tätig. In Deutschland wird ESRI Inc. durch die 1979 gegründete
ESRI Geoinformatik GmbH in Kranzberg bei München als exklusivem Distributor vertreten.
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turiert, organisiert oder über Metadaten dokumentiert werden sollen. Hierzu gehören
Karten, Globen, Datensätze, Modelle, Metadaten und Dienste.

ArcToolbox Arc Toolbox vereint alle Werkzeuge, mit denen man vorhandene Daten
bearbeiten kann. Es dient als Zusammenfassung aller möglichen Operationen auf Daten
und Datensätzen.

Spatial Analyst Für die Analyse räumlicher Beziehungen von Daten, zur Erstellung von
Funktionsmodellen und für komplexe Berechnungen gibt es das Modul ArcGIS Spatial
Analyst. Der ArcGIS Spatial Analyst stellt ein großes Repertoire an Werkzeugen und
Analysemöglichkeiten von Rasterdaten zur Verfügung.

5.2.2 ArcGIS Erweiterung 3D–Analyst

Wie bereits in Kapitel 5.2.1 erwähnt, ist die Einbeziehung der dritten Dimension und
damit die Darstellung sowie Analyse von Oberflächendaten, ein zentraler Punkt. Der
ArcGIS 3D-Analyst ist eine Erweiterung, mit der es ermöglicht wird, in drei statt nur
in zwei Dimensionen zu arbeiten. Der 3D-Analyst stellt u.a. folgende Funktionalitäten
bereit:

• die Erstellung von dreidimensionalen Ansichten

• die Abfrage von Oberflächenwerten, Sichtbarkeitsanalysen, Volumenberechnungen

• die Navigation in drei Dimensionen

• die Erzeugung von Videosequenzen aus Visualisierungsergebnissen

• das Im-/Exportieren vorhandener Daten als VRML oder als Image

ArcGIS 3D-Analyst beinhaltet neben der Funktionalität, dreidimensionale Daten zu
bearbeiten, auch zwei Anwendungen, die zur Visualisierung dieser Daten dienen, ArcSce-
ne und ArcGlobe.

ArcScene ArcScene ist eine Anwendung, um dreidimensionale Daten darzustellen und
zu analysieren. Es ist möglich, jede beliebige Perspektive auf die Daten einzunehmen,
wodurch ein realitätsnaher Eindruck vermittelt wird. In der dritten Dimension können
Zusammenhänge sichtbar werden, die in einer zweidimensionalen Darstellung übersehen
würden. Auch zweidimensionale Daten können räumlich dargestellt werden, indem sie
über bestehende Höhenmodelle drapiert werden.

ArcGlobe ArcGlobe kann im Gegensatz zu ArcScene extrem große 3D-Datenbestände
in globalem oder lokalem Kontext visualisieren. Es ist geeignet enorme Datenmassen dar-
zustellen. Auch die räumliche Integration von ’nicht 3D-Daten’ kann mit diesem Modul
realisiert werden.
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5.3 Datentypen

5.3.1 Das Shape-Format

ArcGIS benutzt ein eigenes Datenformat, das Shape-Format. Dieses kann von jedem
Modul der ArcGIS-Reihe, aber auch von anderer GIS-Software gelesen und bearbei-
tet werden. Nicht topologische Geometrie und deren räumliche Informationen werden
in einem Datensatz gespeichert, dem so genannten Shapefile. Ein Shapefile setzt sich
wiederum aus mehreren Dateien mit jeweils gleichem Namen und unterschiedlicher En-
dung zusammen. In Abb. 5.1 werden die wichtigsten Dateien aufgelistet. Als Vorteile der

Datei Funktion
Shapefile.shp Die Hauptdatei in der die Geometrie gespeichert ist. (benötigt)
Shapefile.shx Die Datei die den Index der Geometrie speichert. (benötigt)
Shapefile.dbf Eine Tabelle im dBASE Format die die Attributinformation spei-

chert. (benötigt)
Shapefile.sbn
Shapefile.sbx

Dateien zur Speicherung des räumlichen Index.

Shapefile.xml Metadatei für ArcGIS welche Informationen über das Shapefile
enthält.

Abbildung 5.1: Auflistung der Daten die für ein Shapefile benötigt werden

Aufteilung in mehrere Dateien ergeben sich nach Klemmer [7]:

• Datensätze können schneller angezeigt werden

• einzelne Datensätze können aus unterschiedlichen Quellen miteinander verknüpft
werden

• eine vereinfachte Editierbarkeit

• die Daten brauchen weniger Speicherplatz und sind einfacher zu lesen und zu schrei-
ben

Ein Shapefile kann genau eine Geometrieart an Vektordaten besitzen. Diese werden im
nächsten Kapitel näher erläutert.
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5.3.2 Vektordaten

Vektordaten beschreiben die Geometrie von Punkten, Linien und Flächen und werden
über Koordinaten definiert. Diese können entweder durch Messverfahren, wie das La-
serscanning, oder mittels Kamera erhoben werden. Weiterhin ist die manuelle Eingabe
von Vektordaten in ArcGIS möglich. Der Punkt, als kleinste geometrische Einheit, bildet
dabei die Grundlage für alle Vektormodelle.

Punkte haben X-, Y-Koordinaten und, wenn es benötigt wird, eine Z-Koordinate, um
eine Höhe zu repräsentieren. Sie besitzen keine räumliche Ausdehnung und somit keinen
Radius. Standorte von Bäumen oder Straßenschilder werden meist als Punkt dargestellt.

Linien bestehen aus miteinander verbundenen, geordneten Punkten und deren dazu-
gehörigen Koordinaten. Sie haben keine seitliche Ausdehnung und somit keine Breite.
Verkehrswege werden mittels Linien dargestellt

Flächen bestehen aus geschlossenen Linien, d.h. Anfangs- und Endpunkt sind iden-
tisch. Als zweidimensionales Objekt haben sie eine Ausdehnung in X- und Y-Richtung.
Länder oder Waldgebiete werden als Flächen dargestellt.

Abbildung 5.2: Beispiel für Vektordaten: Der innere Park
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5.3.3 Rasterdaten

Rasterdaten sind im wesentlichen Bilddaten. Diese können aus einem Flugzeug oder
Satelliten aufgenommen und digital bearbeitet werden. Eine weitere Methode ist, ein
Raster aus Oberflächen-Scannings mittels Algorithmen zu interpolieren, worauf am En-
de dieses Abschnitts eingegangen werden soll. Ein Rasterdatensatz ist ein Gitternetz,
bestehend aus einzelnen Pixeln (Zellen), die regelmäßig in Zeilen und Spalten zu einer
Matrix angeordnet sind. Die Genauigkeit wird hierbei von der Zelldimension bestimmt.
Je kleiner die Zellen sind, desto präziser ist die Oberflächendarstellung.

Rasterdaten werden hauptsächlich für die Repräsentation von Bildern und Höhenmo-
dellen (Abb. 5.3) eingesetzt. Dabei enthält jede einzelne Zelle einen X- und Y-Wert, bei
Höhenmodellen einen Z-Wert, und kann darüber hinaus noch weitere rasterspezifische
Werte beinhalten. Rasterdaten zeigen die Erdoberfläche aus einer senkrechten Sicht von
oben, sind aber im Gegensatz zu Vektordaten in der Regel weniger detailliert, nicht
skalierbar und weniger genau. Rasterdaten dienen in dieser Arbeit vornehmlich der Vi-
sualisierung von Geländedaten, um Eindrücke über Ausdehnung und Größe einzelner
Objekte zu bekommen. Dies stellt eine räumliche Orientierung für die Arbeit mit ande-
ren raumbezogenen Daten dar und bietet eine Vielzahl an Analysemöglichkeiten.

Abbildung 5.3: Rasterdarstellung des inneren Parks. Symbologie: helle bis weiße Bereiche
stellen Erhebungen dar, dunkle bis schwarze Vertiefungen
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Um Rasterdaten aus Shapefiles zu erhalten, müssen die Punkte mit Höhenwert nach
bestimmten Algorithmen interpoliert werden. ArcGIS bietet hier vier Algorithmen, die
durch Interpolation ein Raster erzeugen. Es wird jedoch an dieser Stelle nicht genauer
auf diese Algorithmen eingegangen, sondern auf DeMers [3, ab Seite 266] verwiesen.

5.3.4 Sachdaten

Sachdaten beinhalten zusätzliche Informationen zu Raster- und Vektordaten. Sie werden
separat gespeichert und beschreiben ihrerseits Attribute, die keine geometrischen Daten
enthalten. Zu einer Fläche kann zum Beispiel die Länge der Umrisskanten oder der
Flächeninhalt gespeichert werden.

5.3.5 Das TIN

5.3.5.1 Merkmale eines TINs

Ein weiterer Datentyp, mit dem raumbezogene Daten bearbeitet und dargestellt werden
können, ist das TIN3. Dieser Datentyp steht mit der Aktivierung des 3D-Analyst zur
Verfügung. Ein TIN ist zusammengesetzt aus Knotenpunkten, Kanten, Dreiecken, und
einem Hüllenpolygon. Diese Daten werden für jedes TIN in einem Ordner mit dem
Namen des TINs angelegt. In diesem Ordner befinden sich in der Regel mehrere Dateien,
die die topologische Struktur des TINs beschreiben. Die Dateien definieren ein TIN durch
folgende Werte:

• Anzahl der Dreiecke

• Nummer jedes angrenzenden Dreiecks

• Punkte, die ein Dreieck definieren

• X- und Y-Koordinaten jedes Knotenpunktes

• Höhenwert jedes Knotenpunktes

• Kantentyp jeder Kante des Dreiecks (Kapitel 5.3.5.2)

Der Datentyp wird an dieser Stelle angeführt, da die Arbeit mit TINs einen zentralen
Punkt darstellt und das Verständnis für die Arbeitsweise erleichtert werden soll. Wie in
diesem Kapitel schon erwähnt wurde, ist ein TIN aus mehreren Attributen zusammen-
gesetzt, auf die hier etwas näher eingegangen werden soll.

Knotenpunkte (nodes) bilden die Stützpunkte für das TIN. Sie besitzen einen Hö-
henwert.

Kanten (edges) verbinden jeden Knotenpunkt mit dem nächst gelegenen Nachbarn

3Triangulated Irregular Network
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nach der Delaunay-Triangulation4, um Dreiecke zu formen. Dabei hat jede Kante min-
destens zwei Knoten, wobei aber ein Knoten zwei oder mehr Kanten haben kann.

Dreiecke (polygon) beschreiben einen Teil der TIN-Oberfläche. Die Werte der X-,
Y- und Z-Koordinaten eines Dreiecks können benutzt werden, um verschiedene Infor-
mationen abzuleiten, beispielsweise die Form, Neigung oder Größe der Oberfläche. Das
komplette TIN betrachtend, ist es möglich, weitere Informationen abzuleiten wie Ober-
flächenvolumen, Oberflächenprofile, und es bietet die Möglichkeit, Sichtbarkeitsanalysen
durchzuführen.

Die Hülle (hull) eines TINs ist ein weiteres wesentliches Attribut. Sie besteht aus
einem oder mehreren Polygonen und beinhaltet alle Punkte, die zum Konstruieren des
TINs benötigt werden. Die Hülle definiert das Gebiet des TINs und grenzt dieses ab.
Es ist nur möglich, innerhalb und auf diesen Grenzen zu arbeiten, um beispielsweise
Höhenwerte zu interpolieren, Analysen durchzuführen oder Oberflächenansichten zu ge-
nerieren. Außerhalb der Hülle sind keine Informationen ableitbar. Ein wichtiger Aspekt,
der im weiteren Verlauf der Arbeit noch aufgegriffen werden wird, ist die Konvexität der
Hülle eines TINs. Von ArcGIS erzeugte TINs werden immer konvex erzeugt. Eine konve-
xe Hülle ist ein Polygon mit der Eigenschaft, dass jede Linie, die beliebige zwei Punkte
verbindet, selber in der Hülle oder Teil der Hülle sein muss. Bei Datenmaterial, das kon-
kave Formen beschreibt, wird die Hülle dennoch konvex erzeugt, um die begrenzenden
Kanten zu definieren. Eine nicht-konvexe Hülle muss daher durch den Anwender selbst
definiert werden. Diese wird durch Operationen auf das TIN erzeugt. Ohne diese Ope-
rationen werden inkorrekte Werte, in den Bereichen ohne Datengrundlage, interpoliert
und das TIN somit falsch dargestellt, was die Abbildung 5.4 verdeutlicht.

Abbildung 5.4: Die entstandene konvexe Hülle (bunt) und die Ausdehnung des Daten-
materials (grau) für ein TIN

4Die Delaunay-Triangulation beschreibt eine Technik, um ein kontinuierliches Netz nicht überlappender
Dreiecke aus einem Datensatz von Punkten zu generieren. Die Delaunay-Triangulation ist benannt
nach dem russischen Mathematiker Boris Nikolaevich Delaunay.
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5.3.5.2 Erstellung und Bearbeitung eines TINs

Die Möglichkeit ein TIN zu generieren und zu bearbeiten, nimmt für diese Arbeit eine
zentrale Bedeutung ein. Deshalb soll im Folgenden genauer darauf eingegangen werden,
welche Möglichkeiten in ArcGIS bestehen, ein TIN zu erzeugen, und welche Methodiken
zur Bearbeitung dieser genutzt werden können. Ein TIN kann auf mehrere Arten erzeugt
werden. Im Folgenden soll auf die beiden grundlegenden Verfahren eingegangen werden.

Möglichkeiten der TIN-Erzeugung

• Das erste Verfahren beschreibt die Erzeugung eines TINs aus Vektordaten. Es ist
dabei grundsätzlich möglich, aus jeder Art von Vektordaten ein TIN zu generieren,
seien es Punkte, Linien oder Flächen, wobei der Punkt als elementarer Bestandteil
von Vektordaten fundamental für die Erstellung eines TINs ist (Kapitel 5.3.2). Die
Auflösung des entstehenden TINs ist abhängig von der Punktdichte der Ausgangs-
daten. Darüber hinaus ist es auch möglich, mehrere Datenquellen gleichzeitig in
die Generierung eines TINs einfließen zu lassen. Es kann dabei aber, kein direkter
Einfluss auf die Funktion und damit auf die Reihenfolge, in der die Eingangsdaten
bearbeitet werden, genommen werden. Die Reihenfolge ist durch die Methoden, mit
denen sie erzeugt werden, festgelegt und entspricht der Reihenfolge der Auflistung
in Abb. 5.5. Dieser Nachteil kann aber umgangen werden, indem der Anwender den
Prozess manuell durchführt. Dann ist die Reihenfolge der Operationen auf das TIN
selbst bestimmbar. Dabei ist ein mehrfacher Durchlauf unumgänglich. Ein weite-
rer Aspekt, auf den der Anwender Einfluss bei der Triangulation des TINs nehmen
kann, ist die Art der Kantenbildung, da jede mit dem TIN verbundene Operation
Bruchkanten erzeugt. Diese Bruchkanten, sogenannte ’Breaklines’, definieren und
kontrollieren das Verhalten der Oberfläche in Hinsicht auf Glätte und Kontinuität.
Es gibt zwei Typen von Breaklines, die die Oberflächenbeschaffenheit beschreiben.
Unterschieden wird hierbei in ’Hard breaklines’ und ’Soft breaklines’.

– ’Soft breaklines’ werden genutzt, um sicherzustellen, dass bekannte Höhen-
werte entlang eines Linen-Merkmals in das TIN eingearbeitet werden, ohne
Unterbrechungen in Oberflächenbeschaffenheit und Neigung zu erzeugen.

– ’Hard-breaklines’ definieren Unterbrechungen in der Oberflächengeometrie und
steigern somit die Genauigkeit. Sie stellen abrupte Sprungstellen oder starke
Neigungswechsel dar.

Weiterhin sei erwähnt, dass die Bearbeitung mit mehreren Datenquellen in einem
Arbeitsgang immer andere Ergebnisse bringt, als die Durchführung in mehreren
Schritten.

• Das zweite Verfahren beschreibt die Erzeugung eines TINs mittels Rasterdaten. Im
Vergleich zu der ersten Variante bilden hier nicht Vektordaten die Grundlage, son-
dern Rasterdaten. Die Detailgenauigkeit des zu erzeugenden TINs ist von mehreren
Faktoren abhängig. Zum einen ist die Genauigkeit, beziehungsweise die Zellengröße,
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des Rasters ausschlaggebend, und zum anderen ist die Detailgenauigkeit abhän-
gig von einem Toleranzwert, der in der Funktion zur Erzeugung festgelegt werden
kann. Der Toleranzwert bestimmt den maximalen tolerierbaren Unterschied zwi-
schen der dargestellten Höhe der Punkte des Ausgangsrasters und der Höhe der
Punkte des zu erstellenden TINs. Dieser Wert ist durch ArcGIS voreingestellt, kann
aber durch den Anwender verändert werden. Bei dieser Art der TIN-Generierung
wird anfangs ein TIN erzeugt, mit ausreichend genug Punkten, um die komplette
Fläche des Rasters abzudecken. Die Oberfläche des TINs wird dann durch einen
iterativen Prozess, der mehr Stützpunkte einfügt, schrittweise verfeinert, bis die
spezifizierte Toleranz erreicht ist. Die Funktion stellt somit nur ein Näherungs-
verfahren dar, kann aber bei minimalem Toleranzwert die Genauigkeit der ersten
Variante erreichen, wenn die Ausgangsdaten die selben sind. Dieses aus Rasterda-
ten erstandene TIN kann mit den selben Methoden bearbeitet werden wie ein TIN,
das aus Vektordaten erzeugt wurde.

Triangulation
(Breakline)

Höhenwert Geometrieart Effekt

Masspoints erforderlich Punktwolken, Stütz-
punkte von Linien oder
Flächen

TIN wird anhand der Höhen-
werte erzeugt

Breaklines
(Soft/Hard)

optional Linien Strukturlinien bzw. Bruch-
kanten werden eingefügt

Value fill
(Soft/Hard)

optional Flächen allen Flächen innerhalb eines
Bereiches wird ein Integer-
Wert zugeordnet

Replace
(Soft/Hard)

erforderlich Flächen erzeugt ebene Flächen mit be-
stimmter Höhe (Gewässer)

Clip
(Soft/Hard)

optional Flächen Eine Fläche definiert eine
Schnittkante, an der das TIN
abgeschnitten wird

Erase
(Soft/Hard)

optional Flächen betreffende Polygone werden
entfernt

Abbildung 5.5: Reihenfolge der Möglichkeiten bei der TIN-Bearbeitung, aufgelistet nach
der Art der Triangulation.

Bearbeitung eines TINs

Den Möglichkeiten ein TIN zu bearbeiten, sind erhebliche Grenzen gesetzt. Es kön-
nen hierbei nur die Operationen zum Einsatz kommenn, die auch auch zur Erstellung
eines TINs dienen (Abb. 5.5). Das heißt, es können nur Informationen aus Shapefiles zur
Bearbeitung genutzt werden. Folglich ist kein direkter Eingriff in die Topologie des TINs
möglich. Das bedeutet, dass eventuelle Fehler oder Unzulänglichkeiten bei der Erzeugung
des TINs nur mit zusätzlichem Datenmaterial und Aufwand behoben werden können.
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Diese Unzulänglichkeiten machen es nötig zusätzliche Software zu verwenden, um im
weiteren Verlauf der Arbeit zu einem zufriedenstellenden Ergebnis zu kommen. Diese
ermöglicht es, einzelne Punkte oder Bereiche gezielt zu verändern und zu manipulieren.

5.4 Relevanz eines Modellers

Wie schon in Kap. 5.3.5.2 erwähnt, sind der Bearbeitung des TINs erhebliche Grenzen
gesetzt. Unter dem Aspekt einer Darstellung in VRML bedarf es einer Anpassung an
dieses Format. Hierbei sind die Größe der Daten und die Performance der VRML-Szenen
ausschlaggebend. Die Vereinfachung des TINs von einem konkreten Modell zu einer ver-
einfachten Version steht hierbei im Vordergrund. Weniger Datenvolumen, jedoch hohe
Genauigkeit sind ein wichtiges Kriterium für die Visualisierung in VRML, und dahin-
gehend ist die Bearbeitung durch die Methoden in ArcGIS stark eingeschränkt. ArcGIS
ist kein 3D-Modeller, und es besteht daher nur sehr bedingt die Möglichkeit, Gebäude,
beziehungsweise Objekte, adäquat darzustellen. Es ist möglich, in ArcScene schemen-
haft Objekte wie Gebäude oder Bäume zu symbolisieren, aber es ist nicht möglich, diese
zufriedenstellend zu exportieren. Es bedarf einer Software, die die erzeugten Daten aus
ArcGIS einlesen und bearbeiten kann und es ermöglicht, diese mit andern Objekten in
eine Szenerie zu kombinieren. Weitere Anforderungen sind räumliche Korrektheit und
die Im- und Exportierbarkeit in das VRML-Format. Dafür bedarf es dieser speziellen
Software. Ein 3D-Modeller stellt all diese Funktionalitäten bereit.

Es sind diverse freie und lizenzpflichtige Programme verfügbar, mit denen es möglich
ist, die gestellte Aufgabe zu lösen. Für diese Arbeit soll die 3D-Computergrafik Software
Maya5 von Autodesk6 in der Version 8.5 Verwendung finden. An dieser Stelle wird nicht
genauer auf das Programm eingegangen, sondern auf Mahintorbai [10] verwiesen.

Maya kommt zum Einsatz, um genannte Defizite in ArcGIS auszugleichen, um Ge-
bäude und Objekte zu erstellen und sie mit den GIS-basierten Modellen zu einer Szene
zu kombinieren. Weiterhin dient Maya dazu, die Beschaffenheit der TIN-Oberfläche zu
vereinfachen.

5Maya ist eine professionelle 3D-Visualisierungs- und Animationssoftware. Genutzt wird sie in der Film-
und Fernsehindustrie und bei der Erstellung von Grafiken für Computer- und Videospiele.

6Autodesk ist ein Softwareunternehmen, das auf Programme für computergestützte Konstruktion, wie
CAD-Anwendungen oder 3D-Grafik- und Animationssoftware, spezialisiert ist.
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5.5 Vorhandenes Datenmaterial

5.5.1 Überfliegungsgebiet

Das darzustellende Gebiet, der innere Branitzer Park, ist ein Teilgebiet des Areals, das
durch eine Überfliegung mit einem Laserscanner digitalisiert wurde. Das gesamte Areal
wurde in 51 horizontalen Spuren mittels Airborne Laser Scanning7 abgetastet. Der Auf-
trag wurde 2004 vom Lehrstuhl Altlasten der BTU Cottbus an die Milan-Flug GmbH
vergeben. Die Daten der Überfliegung beschreiben ein ca. 20 km2 großes Gebiet. Es um-
fasst in ETRS898-Koordinaten folgenden Bereich: NW-Ecke 5735000/3454000 SO-Ecke:
573000/3460000. Die Scanauflösung beträgt 1x1 m9.

Abbildung 5.6: Das Überfliegungsgebiet: Die bunten Linien symbolisieren die 51 Spuren
der Überfliegung. Die roten Linien beschreiben ein Raster, das sich aus
den einzelnen Quadraten zusammensetzt, die jeweils einem Bereich von
1x1 km entsprechen.

7Airborne Laser Scanning Systeme werden in Flugzeugen oder Helikoptern eingebaut und dienen der
Erfassung der Geländeoberfläche mit hoher Präzision. Ein Laser tastet beim Überfliegen das Terrain
ab und registriert, durch Messen der Laufzeit des Signals, die Entfernung zum Boden.

8Das Europäische Terrestrische Referenzsystem 1989 ist ein geozentrisches Bezugssystem.
9Für weiterführende Informationen zur Überfliegung steht das Flugprotokoll beim Lehrstuhl Altlasten

der BTU Cottbus zur Verfügung.
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5.5.2 Datensätze

Es wurden jeweils Teilbereiche aus den folgenden, näher beschriebenen Datensätzen der
Überfliegung und relevante Daten des bestehenden Kartenmaterials, sowie teilweise vor-
handene Modelle verwendet. Sie wurden vom Lehrstuhl Altlasten der BTU Cottbus,
durch die Stiftung des Branitzer Parks und vom Systemhaus Stahr zur Verfügung ge-
stellt. Die Nutzung geschah mit Genehmigung des jeweiligen Urhebers.

5.5.2.1 Daten der Überfliegung

Als Grundlage für die Erzeugung eines Geländemodells mittels GIS, dienen die Daten der
Überfliegung. Alle Daten sind digitale Höhenmodelle (DHM). Diese unterscheiden sich
in der Art des Höhenmodells (DSM10/DTM11), in ihrer Form, sowie ihrem Dateiformat.
Die Gebietsausdehnung und die Rasterauflösung sind für alle Modelle gleich. (Kap. 5.5.1)

• Spuren: Hierbei liegen die Daten der 51 Spuren der Überfliegung in einer Textdatei
im ASCII-Format vor. Dabei bildet jede Spur eine Datei mit den Werten für die
jeweiligen X-, Y- und Z-Koordinaten der Messpunkte.

• Kacheln: Die Koordinaten sind quadratisch, zu jeweils 30 (5x6) Teilgebieten mit
einer jeweiligen Ausdehnung von 1x1 km großen Kacheln, angeordnet. Jedes Teil-
gebiet beinhaltet 1 Mio. Messpunkte. Diese Daten liegen jeweils als DTM und DSM
in Dateien im Grid-Format und in Textdateien im ASCII-Format vor.

Relevant für diese Arbeit sind hauptsächlich die DTM-Daten der Textdateien im ASCII-
Format, da diese das genaue Abbild der Oberfläche ohne Bebauung und Vegetation
widerspiegeln, und ein geeignetes Format für den Import in ArcGIS besitzen.

5.5.2.2 Kartenmaterial vom Branitzer Park

Das Material, das durch die Stiftung des Branitzer Parks gestellt wurde, ist größtenteils
GIS bezogen. Es beinhaltet folgende Daten:

• Datenmaterial vom aktuellen Zustand: Neben einer Vielzahl an Vektordaten
liegt auch eine CAD-Karte vom inneren Park vor. In dieser Karte sind Gewässer,
Wege, Standpunkte von Bäumen, Gebäude, Brücken, markante Geländelinien und
dessen Höhen verzeichnet. Die GIS bezogenen Daten beinhalten unter anderem
Informationen über:

– Forstflächen

– Baumstandpunkte

– Denkmäler

– Schutzgebiete

10(Digital Surface Model) – ist eine Repräsentation der Erdoberfläche mit Vegetation und Gebäuden.
11(Digital Terrain Model) – ist eine generelle, gefilterte Version der Oberfläche. Es enthält keinerlei

Gebäude oder Vegetation und kann als auch ’pures’ Erdmodell bezeichnet werden.
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– Bebauung

– Fließgewässer und Standgewässer

– Sichtachsen

– Verkehrswege

• Datenmaterial von historischen Zuständen: Das vorhandene Datenmaterial,
das die Historie des Parks beschreibt, betrifft die Jahreszahlen 1845 und 1846, 1853,
1875 und 1903. Die im folgenden aufgeführten Daten sind nicht für alle Jahreszah-
len vollständig. Für einige Zeiträume gibt es nur eine Teilauswahl. Ausgenommen
sind 1845 und 1875, die durch alle, im weiteren aufgezählten, Daten beschrieben
sind. Darüber hinaus ist noch weiteres, nicht GIS bezogenes Bildmaterial vorhan-
den, auf denen Gebäude oder komplette Bereiche des historischen Branitzer Parks
zu sehen sind. Dazu zählt eine Kopie einer Graphitzeichnung von Wilhelm Heinrich
Masser, genannt Billy, dem ’Geheimsekretär’ Pücklers12. Auf dieser ist das Schloss
um 1845 mit umliegendem Terrain und Vegetation zu sehen. Weiterhin liegt ein
Bildband vor, in dem Fotografien von Bereichen des Parks zu verschiedenen Zeiten
abgebildet sind [14]. Bis auf Karten, die im Rasterdaten-Format vorhanden sind,
ist der Rest durch die folgenden Vektordaten beschrieben:

– Forstflächen

– Bebauung

– Fließgewässer und Standgewässer

– Verkehrswege

5.5.2.3 VRML-Material

Das VRML-Material wurde durch das Systemhaus Stahr gestellt. Es umfasst folgende
Bereiche:

• VRML-Modell vom Pyramidenground mit Bebauung und Vegetation. Dazu zählen
das Gelände mit den beiden Pyramiden sowie den Wegen, das Wasser, ein einfaches
Modell des Himmels und exemplarisch eingesetzte Bäume.

• VRML-Modell vom Schlossground mit hochpolygonalen, texturierten Modellen.
Dazu zählen das Gelände um das Schloss mit den Wegen, das Schloss, der Marstall
und das Kavaliershaus, und exemplarisch eingesetzten Bäumen

• VRML-Modell von der Cottbuser Altstadt um 1720. Es beinhaltet nicht texturierte
einfache Gebäude und vereinzelt Bäume innerhalb der Stadt.

• Texturen für Häuser, Pflanzen und Bäume.

12Das Bild stammt aus dem Privatbesitz von H.G. von Pückler und wurde als Kopie vom Branitzer Park
zur Verfügung gestellt
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6 Erstellung der Modelle mit ArcGIS und
Maya

6.1 Bearbeitung des Rohmaterials mit ArcGIS – Überführung
in ein TIN

Um von den Rohdaten der Überfliegung zu einer adäquaten Repräsentation der Ober-
fläche des inneren Branitzer Parks zu kommen, bedarf es einiger Bearbeitungsschritte in
ArcGIS. Die im folgenden aufgezählten Schritte beschreiben eine Vorgehensweise, die als
Resultat ein absolut konkretes TIN, das alle Geländeinformation enthält, produziert.

Import der Daten in ArcGIS

Die Grundlage für alle Szenarien sind die Daten der Überfliegung, die das darzustellende
Terrain ohne Bebauung und Vegetation, mittels X-, Y-, und Z-Koordinaten, darstellen.
Die Daten liegen im ASCII-Fromat vor und müssen in ein für ArcGIS lesbares Format
überführt werden. Dazu bietet ArcGIS die Funktion Textdateien im Tabellen-Format zu
importieren. Um das zu ermöglichen, legt ArcGIS in jedem Verzeichnis mit Textdateien,
das mit ArcCatalog oder ArcMap durchsucht oder geöffnet wird, automatisch eine Datei,
die Schema.ini, an. Diese Datei nimmt Bezug auf die Textdateien in dem Verzeichnis, in
dem sie liegt. In der Datei Schema.ini steht neben einem Verweis auf die Datenquelle ein
Eintrag zum Textbegrenzer und Dezimaltrenner.

Durch die automatische Generierung dieser Datei, durch ArcGIS, ergaben sich im Zuge
der Importierung der Daten einige Probleme. Es ist möglich, dass die Datei Schema.ini
falsche Einträge enthält, die dazu führen können, dass ArcGIS die Textdatei inkorrekt
interpretiert und demnach falsch importiert. Fehlerquellen sind falsche Formatierung
der zu importierenden Textdatei, und die inkorrekte Interpretation des Dezimaltrenners
durch die Datei Schema.ini. Die zu importierende Datei, ihrerseits, muss einen Header
besitzen, in dem die Spalten der Tabelle mit einem nicht numerischen Wert definiert sind.
Die falsche Interpretation der Daten durch die Datei Schema.ini andererseits, ist darauf
zurückzuführen, dass der Dezimaltrenner standardmäßig aus der Einstellung von Win-
dows übernommen wird. Im Deutschen ist bei der Regionseinstellung ein Komma vom
Betriebssystem vordefiniert. Sollte die zu importierende Datei einen Punkt als Dezimalt-
renner besitzen, kommt es zu beschriebenen Problemen. Es ist nötig die Datei Schema.ini
manuell zu bearbeiten und gegebenenfalls Textbegrenzer und Dezimlatrenner von Hand
zu ändern, um genannte Probleme zu vermeiden. Alternativ wäre die Formatierung der
Textdatei möglich, um den Dezimaltrenner manuell zu ersetzen. Für die Arbeit wurde
die Datei Schema.ini modifiziert, um einen fehlerfreien Import zu gewährleisten.
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X Y Z
3455000.50 5732000.50 74 .91
3455001.50 5732000.50 74 .93
3455002.50 5732000.50 74 .95
. . . .

Abbildung 6.1: Auszug einer Textdatei mit den Koordinaten des Geländes

[ Datei . txt ]
Format=CSVDelimited

Abbildung 6.2: Der Eintrag in der Datei Schema.ini nach der automatischen Generierung
durch ArcGIS. Der Textbegrenzer ist ein Komma und der Dezimaltrenner
wird standardmäßig aus der Regionseinstellung von Windows übernom-
men

[ Datei . txt ]
Format=Del imited ( )
DecimalSymbol=.

Abbildung 6.3: Der Eintrag in der Datei Schema.ini nach der manuellen Bearbeitung.
Der Textbegrenzer ist ein Leerzeichen und der Dezimaltrenner ist der
Punkt

Teilbereiche identifizieren

Da der innere Park nur ein Teilgebiet der Überfliegung darstellt, ist es im Vorfeld not-
wendig diejenigen Teilbereiche zu bestimmen, die relevant für eine Importierung und
weitere Bearbeitung sind. ArcGIS benötigt Vektor- oder Rasterdaten, um Geländedaten
zu visualisieren. Dazu ist es erforderlich, die Textdateien zu importieren und dann in
ein für ArcGIS visualisierbares Format umzuwandeln. Erst anhand dieses Formats ist
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es möglich, die flächenmäßige Ausdehnung zu erkennen und räumliche Informationen
zu erhalten. Um einen räumlichen Eindruck zu bekommen, müsste aus Vektordaten ein
TIN erzeugt, oder durch Interpolation ein Rastersbild abgeleitet werden. Damit Ent-
scheidungen getroffen werden konnten, welche Daten relevant sind, wäre es notwendig
gewesen, alle 30 Teilbereiche zu jeweils 1 Mio. Punkte-Tripeln, mit der oben beschriebe-
nen Prozedur zu untersuchen. Aus Aufwands- und Zeitgründen wurde an dieser Stelle
ein Programm genutzt, um die selben Daten im Grid-Format ohne vorangehende Bear-
beitung einzulesen und zu visualisieren. Die Bezeichnung der einzelnen Daten im Grid-
und im Textformat ist, bis auf die Dateiendung, gleich. Dies machte die Bestimmung der
relevanten Teilbereiche ohne weiteres möglich. Zur Visualisierung kam das Programm
Global Mapper1 in der Version 9.01 zum Einsatz. Hiermit war es möglich, eine sofortige
Darstellung der Daten zu bekommen, um zu entscheiden welche Teilbereiche für die wei-
tere Bearbeitung benötigt werden. Die Auswertung in Global Mapper zeigte deutlich,
dass der innere Park auf dem Schnittpunkt von vier aneinander angrenzenden Teilberei-
chen liegt. Als markante Anhaltspunkte dienten die Pyramiden und die Kanäle, die den
kompletten inneren Park durchziehen. Mit den nun bekannten Teilbereichen konnten die
Daten korrekt in ArcGIS eingelesen und in Point-Shapes umgewandelt werden.

ArcMap -> Tools -> Add XY Data

Es entsteht ein Layer, der die zuvor eingelesenen Daten repräsentiert. Nach dem Einlesen
dieser Daten muss daraus noch ein Shapefile erzeugt werden.

ArcMap -> Rechtsklick auf den Layer -> Data -> Export Data

Alle vier Teilbereiche liegen somit als Point-Shape vor und können nun in ArcGIS weiter
bearbeitet werden. Dabei sind an dieser Stelle noch keine Topologien sichtbar.

Teilbereiche zusammenführen

Eine weitere Bearbeitung, und die damit verbundene spätere Überführung in ein TIN,
machten es nötig die einzelnen Bereiche zu Einem zu verbinden.

Toolbox -> Data Managment -> General -> Merge

Nach dem Zusammenführen liegt ein Point-Shape als Quadrat mit einer Gesamtzahl
von vier Mio. Punkten vor. Es repräsentiert die Realität in einer Ausdehnung von 2x2
km. Um einen bildlichen Gesamteindruck zu bekommen, wurde aus diesem Shapefile
durch Interpolation ein Rasterbild abgeleitet.

1Die Software Global Mapper der Firma Global Mapper Software LLC kann eine Vielzahl von Daten
ohne vorangegangene Bearbeitung visualisieren, und bietet dabei eine Vielzahl an Möglichkeiten zur
Bearbeitung von raumbezogenen Daten
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Toolbox -> Spatial Analyst Tools -> Interpolation -> Natural Neighbor

Wie in Kapitel 5.3.3 erwähnt, gibt es noch weitere Methoden ein Raster zu interpolie-
ren. Die Variante ’Natural Neighbor’ wurde benutzt, da ihr ein verhältnismäßig einfacher
Algorithmus zugrunde liegt, und sie die effektivste und schnellste Variante für die Inter-
polation dieser Ausgangsdaten ist.

Ausschnitt des inneren Parks

Für das Projekt ist nur die Visualisierung des inneren Parks relevant. Somit ist auch
nur der Bereich des Point-Shapes, der den inneren Park darstellt, von weiterem Inter-
esse, und soll aus dem Bestehenden herausgelöst werden. Anhand der Rasterdaten ist
die Form des inneren Parks zwar ungefähr erkennbar, aber nicht ausreichend genau,
um Grenzen zu definieren. Es besteht keine klare Objektbegrenzung und die Übergän-
ge sind fließend. Mit Hilfe der CAD-Karte ist es möglich die Grenzen des Parks genau
zu definieren, und eine präzise ’Stanzform’ zu erstellen. Damit die CAD-Karte an der
räumlich korrekten Position im GIS dargestellt wird, ist es nötig diese zu georeferenzie-
ren. Um Datensätze zu georeferenzieren, braucht man Bezugspunkte und deren exakte
Koordinaten innerhalb eines definierten Koordinatensystems. Wieviele Punkte man für
eine Georeferenzierung benötigt, hängt unter anderem von der Auswahl der Punkte und
von den Genauigkeitsanforderungen ab. In der Regel benötigt man mindestens drei Re-
ferenzpunkte. In ArcGIS gibt es dafür zwei verschiedene Varianten.

• Die erste Variante ist die Referenzierung durch Auswahl von Punkten in dem zu
referenzierenden Bild, deren Koordinaten bekannt sind, und diese dann manuell
einzugeben.

• Die zweite Variante ist die ’visuelle’ Referenzierung auf einen vorhandenen Daten-
satz, das heißt ein Punkt wird zunächst in dem zu referenzierenden Bild angegeben,
und anschließend der korrespondierende Punkt in einem bereits georeferenziertem
Datensatz bestätigt.

Da die Koordinaten von bestimmten Punkten in der zu referenzierenden Karte nicht be-
kannt waren, kam hier Variante zwei zum Einsatz. Als georefernzierter Datensatz diente
ein Raster, das aus dem großen Shapefile erzeugt wurde. Markante Punkte, die leicht
aus dem Rasterbild zu erkennen sind, dienten als Referenzpunkte. Von diesen wurden die
Koordinaten notiert, um sie anschließend auf das zu referenzierende Bild zu übertragen.
Punkte mit größerem Z-Wert werden heller dargestellt als Punkte mit niedrigerem Z-
Wert und sind so leichter erkennbar. Es boten sich folgende drei Referenzpunkte an: die
Spitze der Wasserpyramide, die Spitze der Landpyramide und die Spitze des Hermann-
bergs. Diese drei Punkte haben jeweils einen Maximalwert im Vergleich zum umliegenden
Gebiet, und sind somit gut geeignet. Mit diesen drei Koordinatenpaaren ist es möglich
den Datensatz zu georeferenzieren. Nach dem Laden in ArcMap wird der Datensatz fol-
gendermaßen referenziert:
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Toolbar ’Georeferncing’ -> Add Control Points

Die zu referenzierende Stelle wird mit linker Maustaste angeklickt, und dann mit rechter
Maustaste ’Input X and Y’ ausgewählt. Dort werden nun die vorher, anhand des Raster-
bilds ermittelten Koordinaten, eingegeben. Gegebenenfalls sollte man so weit wie möglich
auf die Punkte, die man referenzieren will zoomen, um möglichst genau zu arbeiten. Die
Karte wird sofort referenziert und ArcGIS ’schiebt’ dann den Datensatz in die richtige
Lage. Die räumliche Lage ist nun korrekt, aber die räumliche Ausdehnung kann hier noch
abweichen, deshalb wurde mit den anderen Punkten ebenso verfahren. Ergebnis dieses
Verfahrens ist eine Liste von Punkten mit zwei Koordinatenpaaren, einem Koordinaten-
paar in Bildkoordinaten und einem in dem zu referenzierenden Koordinatensystem. Die
CAD-Karte hat danach die präzise Lage und deckt sich mit dem Rasterbild.

Auf der Basis der CAD-Karte wurde ein Polygon-Shape erstellt, welches die Grenzen
des inneren Parks definiert. Dabei diente die CAD-Karte als Vorlage. Dazu musste ein
neues Shapefile erstellt werden, dessen geometrische Grundlage ein Polygon bildet. Dies
geschieht in der Anwendung ArcCatalog.

ArcCatalog -> File -> New -> Shapefile

Zum Zeitpunkt der Erstellung in ArcCatalog, hat das Polygon-Shape weder Geome-
trie noch räumliche Informationen. Um dem Polygon-Shape eine Geometrie sowie eine
räumliche Zuordnung zuzuweisen, bedarf es ArcMap. Das noch leere Polygon-Shape wird
dort geladen und anschließend bearbeitet.

ArcMap -> Menüleiste ’Editor’ aktivieren -> im Editor ’Start Editing’ -> Task: Create
New Feature -> Target: Polygon-shape

Nach dem Erzeugen des Polygon-Shapes ist es möglich, den gewünschten Bereich da-
mit auszuschneiden.

Toolbox -> Analysis Tools -> Extract -> Clip

Ausgeschnitten hat das Point-Shape eine Größe von 1 Mio. Punkten und klar definierte
Grenzen. Das so entstandene Point-Shape bildet die Grundlage für die Erzeugung des
TINs. Desweiteren ist es möglich, aus diesem auch wieder ein Raster zu interpolieren,
um eine räumliche Vorstellung zu bekommen.

TIN-Erzeugung

In der Anwendung ArcScene ist es jetzt möglich aus dem Point-Shape ein TIN zu erzeu-
gen. Dabei gibt es hier zwei grundlegend verschiedene Wege, die in Kapitel 5.3.5.2 näher
beschrieben wurden. Obwohl es möglich ist, mit beiden Varianten gleiche Ergebnisse zu
erzielen, da das Ausgangsmaterial für beide Datentypen gleich ist, wurde entschieden,
das TIN in Einzelschritten aus dem Point-Shape zu erzeugen. Hierdurch wird der Ar-
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beitsschritt der Erstellung eines Rasters aus Vektordaten eingespart.

ArcScene -> 3D Analyst -> Create/Modify TIN -> Create Tin from Features

Das Point-Shape wird mit den folgenden Optionen trianguliert:

Height source: Z
Triangulate as: mass points

Tag value field: <None>

Alternativ die Erzeugung des TIN’s aus einem Raster:

Toolbox -> 3D-Analyst Tools -> Conversion -> From Raster -> Raster to TIN

Folgende Optionen müssen bei der Erstellung gesetzt werden, um auf ein annähernd
gleiches Ergebnis zu kommen wie bei der Triangulation aus Vektordaten:

Z Tolerance: 0,01

Das entstandene TIN hat, so wie das zugrunde liegende Point-Shape, ca. 1 Mio. gleich-
mäßig angeordnete Punkte mit korrekter Darstellung der Höhenwerte. Da, wie in Kapitel
5.3.5.1 erwähnt, ein TIN mit einer konvexen Hülle erzeugt wird, die Grenzen des Bra-
nitzer Parks aber nicht durchgehend konvex sind, war es abschließend erforderlich, dass
erzeugte TIN mit Hilfe der Clip-Operation (Tab.: 5.5) auszuschneiden.

ArcScene -> 3D Analyst -> Create/Modify TIN -> Add Features to TIN

Das erzeugte Polygon-Shape, das die Parkgrenzen definiert, ging mit folgenden Optionen
in die Triangulation des TIN’s ein:

Height source: <None>
Triangulate as: hard clip
Tag value field: <None>

Das somit entstandene TIN bildete die Grundlage zur Erzeugung der verschiedenen
Landschaftsmodelle.

6.2 Erzeugung eines aktuellen Modells

6.2.1 Einarbeitung zusätzlicher Information in das TIN

6.2.1.1 Nachbearbeitung des TINs

Unzulänglichkeiten bei der Erzeugung machten es notwendig, zusätzliche Informationen
in das entstandene TIN einzuarbeiten, um eine brauchbare Repräsentation der Oberflä-
che des Parks zu erhalten. Ein gravierender Aspekt war die Fehldarstellung der Flüsse
und Seen im Branitzer Park. Die Gebiete, die von Wasser bedeckt sind, werden im
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TIN überhöht dargestellt, und ergeben ein falsches Abbild der eigentlichen Oberfläche.
Die Inseln bilden keine eigenständigen Objekte, sondern gehen fließend in die Darstel-
lung des Wassers über. (Abb. 6.4 a) Das ist auf eingeschränkte Messwertaufnahme an
Wasseroberflächen durch real existierende, physikalische und optische Gesetzmäßigkeiten
zurückzuführen2. Weiterhin sind an Brückenstandpunkten verfälschte Werte im TIN zu
erkennen. Die Oberfläche ist an betreffenden Stellen falsch dargestellt. (Abb. 6.4 b)

(a) Hervorgehoben: eine Insel neben dem
Tumulus

(b) Der Bereich der Ägyptischen Brücke.
Daneben die Landypramide

Abbildung 6.4: Fehlerhafte Darstellung im TIN

Um diese Fehler auszugleichen, wird eine Fläche in das TIN eingearbeitet, die ein ein-
heitliches Höhenniveau besitzt und den Grund der Seen und Flüsse darstellen soll. Dafür
werden vorher die Uferkanten auf ein einheitliches Höhenniveau definiert. Es wird ein
Polygon nach dem Abbild der Gewässer des Branitzer Parks, ausgehend von der CAD-
Karte, erstellt. Dazu wird in ArcCatalog ein Polygon-Shape mit Höhenwert erzeugt.
Dieses wurde in ArcMap editiert und in die Form des Gewässers gebracht. Nach der Er-
zeugung der Form konnte dem Polygon-Shape die aus der CAD-Karte ersichtliche Höhe
des Wasserspiegels von 72,6 m über NN zugewiesen werden.

ArcToolbox -> Data Management Tools -> Features -> Adjust 3D Z

Das Polygon-Shape wurde anschließend mit der Operation Replace als ’hard breakli-
ne’ in das TIN eingefügt.

ArcScene -> 3D Analyst -> Create/Modify TIN -> Add Features to TIN

Das Polygon-Shape ging mit folgenden Optionen in die Triangulation des TINs ein:

2siehe Projektdokumentation der Überfliegung

37



Height source: <Feature Z Value>
Triangulate as: hard replace

Tag value field: <None>

Es entstand eine ebene Fläche in dem TIN mit der Höhe des Wasserspiegels, die die Ufer-
kanten auf ein einheitliches Niveau definierte. Dabei blieb die Geometrie der Oberfläche
des Wasserareals erhalten, es wurden lediglich die Höhenwerte an betreffenden Stellen
angepasst. Der Nachteil war, dass Objekte die sich innerhalb dieses Gebietes befanden,
die Inseln und der Tumulus, ihre Höheninformation verloren. Diese mussten im weiteren
Verlauf nachkonstruiert werden. Nachdem die Uferkanten eine homogene Höhe besaßen,
wurde mit dem selben Wasser-Polygon-Shape der Wassergrund in das TIN eingearbei-
tet. Davon ausgehend, dass die Uferkanten nicht total senkrecht sind, was dem realen
Abbild entspricht, wurde eine Kopie des erzeugten Polygons an den Kanten um 10 cm
geschrumpft.

ArcToolbox -> Analysis Tools -> Poximity -> Buffer

Distance: -0,1

Das Höhenniveau, des zu erzeugenden Polygons, wird auf 71,8 m über NN festgelegt und
stützt sich auf messtechnische Erhebungen, die im Branitzer Park durchgeführt wurden.
Analog zum vorangegangenem Schritt wurde der Kopie des Wasser-Polygon-Shapes eine
Höhe zugewiesen, und dann mit selben Optionen in das TIN eingearbeitet. Als Resultat
entstand ein Flussbett, mit definierten Uferkanten und einer einheitlichen Tiefe von 80
cm. Die Repräsentation des Wassers wird später im 3D-Modeller realisiert. Ein weite-

Abbildung 6.5: Eingearbeiteter Seen- und Flussgrund. Im Vergleich zu Abb. 6.4 a sind
hier die Uferkanten deutlich erkennbar

res Problem zeigte sich in der Darstellung der Landpyramide. Diese ist mit ihrer klar
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definierten geometrischen Form kaum zu erkennen. (Abb. 6.4 b) Da sie zwar einen Teil
der Oberfläche des Branitzer Parks darstellt, aber auch ein eigenständiges Objekt bildet,
konnte sie im weiteren Verlauf als separates Objekt behandelt werden. Dazu wurde der
Standpunkt abgeflacht und die Pyramide im späterem Verlauf mittels selbst erzeugten
Höhenlinien neu konstruiert. Das Abflachen des Terrains an dieser Stelle erfolgte ähnlich
wie beim Erstellen des Wassergrundes. Es wird hier ein Polygon-Shape mit Höhenwert
in ArcCatalog erzeugt und in ArcMap bearbeitet. Das Polygon hat nach der Erstellung
vier Stützpunkte, und deckt die Fläche der Landpyramide samt umgebenden Wegen ab.
Da das Terrain an dieser Stelle keine homogene Höhe hat, müssen den einzelnen Punk-
ten verschiedene Höhenwerte zugewiesen werden, um eine saubere Eingliederung in die
Umgebung zu gewährleisten. Die Zuweisung einer Höhe eines einzelnen Punktes kann im
’Editor-Modus’ in ArcMap vorgenommen werden.

Im Editor den Task zu ’Modify’ wechseln -> Rechte Taste auf den Punkt -> Proper-
ties

Nachdem das Polygon die richtige Höhe besaß wurde es, wie beim Wassergrund, mit
der Methode ’hard replace’ in das TIN eingearbeitet. Die Vorgehensweise ist analog zu
der vorangegangen Beschreibung des Absenkens des Wassergrundes.

Abbildung 6.6: abgesenkter Bereich der Landpyramide

Ein weiterer Teil der bearbeitet wurde, war das Gebiet der Schlossterrasse. Durch die
Terrasse, die das Schloss umgibt, sind bei dem Scannen verfälschte Werte der Oberfläche
entstanden. An betreffender Stelle ist das Terrain überhöht. Auch das Gebiet des heu-
tigen Besucherzentrums, im Norden des Parks, war zur Zeit der Überfliegung im Bau,
und es befand sich an diesem Ort eine Baugrube. Diese Mängel wurden ebenso wie bei
der Landpyramide mittels selbst erzeugten Polygonen ausgeglichen. Die Arbeitsschritte
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sind analog zu denen der Abflachung der Landpyramide.

(a) Der Bereich des Schlosses und des heu-
tigen Besucherzentrums nach der Erzeu-
gung des TIN’s

(b) Die Bereiche nach der Bearbeitung

Abbildung 6.7: Fehlerhafte Darstellung im Bereich des Schlosses und des heutigen Be-
sucherzentrums

6.2.1.2 Einarbeitung verlorengegangener Objekte

Nachdem das Gelände jetzt eine Topologie aufweist, die mit dem heutigen Stand ver-
gleichbar ist, müssen Objekte, die durch die Nachbearbeitung verloren gegangen sind,
wieder zurückgeführt werden. Dazu zählen die Inseln und die Wasser- sowie Landpy-
ramide. Diese sollen nicht in das bestehende Gelände-TIN integriert werden, sondern
vielmehr als einzelne TIN-Objekte in die Szene einfließen. Anhand der CAD-Karte ist es
möglich, die Formen der Objekte mittels Linien darzustellen, indem sie in ArcGIS nach-
gezeichnet werden. Grundlage dafür sind die in der CAD-Karte vermerkten Positionen
der Umrisslinien. Mit diesen Informationen und den Höhenangaben der CAD-Karte ist es
möglich, die genannten Objekte in ArcMap nachzubauen. Es wurden hierbei Line-Shapes
benutzt, die Höheninformationen beinhalten. Sie stellen sozusagen ein Gitternetz der zu
generierenden Formen dar. Anhand der Landpyramide soll das Prinzip der Konstruktion
erläutert werden. Die Arbeitsschritte, die im folgenden beschrieben werden, gelten auch
für den Tumulus und die Inseln.

In ArcCatalog wurde ein Line-Shape mit Höhenwerten erstellt, in ArcMap geladen
und editiert. Wie schon erwähnt, wurden anhand der CAD-Karte, die Linien in ArcMap
nachgezeichnet. (Abb. 6.8 a) Nachdem das Grundgerüst stand, mussten den einzelnen
Stützpunkten der Linien Höhenwerte zugewiesen werden. Um einen nahtlosen Über-
gang zwischen dem TIN der Repräsentation der Landpyramide und dem TIN, das die
Landschaft repräsentiert, zu gewährleisten, wurden die Höhenwerte für die Punkte der
untersten Linie, den Punkten der Abflachung des Bereiches entnommen. Hierbei ist dar-
auf zu achten, dass jede Umrisslinie eine andere Höhe hat. Von außen nach innen ist
die Höhe ansteigend, wie auf der CAD-Karte zu sehen ist. (Abb. 6.8 b) Nachdem alle
relevanten Linien zur Erzeugung des TINs erstellt wurden, war der letzte Schritt aus
dem Line-Shape ein TIN zu erstellen.
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ArcScene -> 3D Analyst -> Create/Modify TIN -> Create Tin from Features

Das erzeugte Line-Shape wird mit den folgenden Optionen trianguliert:

Height source: <Feature Z Value>
Triangulate as: hard line
Tag value field: <None>

(a) Ausschnitt der CAD-Karte mit der
Landypramide samt Höhenwerten

(b) Das erzeugte Line-Shape

(c) Repräsentation der Landpyramide als
TIN

Abbildung 6.8: Die Erzeugung des TINs der Landpyramide

Das entstandene TIN verwendet die Stützpunkte des Line-Shapes, um die Oberfläche zu
definieren. Die Landpyramide fungiert als eigenständiges TIN, fügt sich aber nahtlos in
das Landschafts-TIN ein, da die räumliche Ausdehnung der Realität entspricht und alle
Größenverhältnisse beibehalten wurden. Gleiches gilt für den Tumulus und die Inseln,
jedoch ist hier beim Prozess der Erstellung der Linien, eine zusätzliche Höhenlinie ein-
zufügen, damit diese Objekte mit dem Grund der Seen und der Flüsse abschließen. Um
dieses zu erreichen, wurde die tiefste Linie, die auf der CAD-Karte verzeichnet ist, dort,
wo das Wasser das Objekt berührt, dupliziert und das Duplikat anschließend gepuffert.
Damit entstand, wie beim Landschafts-TIN, eine nicht total senkrechte Uferkante.

ArcToolbox -> Analysis Tools -> Proximity -> Buffer

Distance: 0,1
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Wie bei der Landpyramide mussten den einzelnen Punkten der Linien noch Höhenwerte
zugewiesen werden.

ArcToolbox -> Data Management Tools -> Features -> Adjust 3D Z

Anschließend wurde aus ihnen ein TIN erstellt. Die Vorgehensweise ist analog zur Er-
zeugung des TINs der Landpyramide. Damit waren alle natürlichen Objekte, die die
Oberfläche des inneren Parks definieren, wiederhergestellt.

Abbildung 6.9: Das bearbeitete TIN mit den nachkonstruierten Objekten

6.2.1.3 Vereinfachung des Geländes

In Hinblick auf die spätere Darstellung gibt es an das Geländemodell mehrere Anforde-
rung, die es gilt in ArcGIS weitesgehend umzusetzen. Ein wesentlicher Faktor, der eine
weitere Bearbeitung unumgänglich macht, ist die Anzahl der Polygone des Gelände-
TINs. Es besteht nach bisheriger Bearbeitung, ohne die separierten Objekte, aus ca.
2 Mio. Polygonen, 6 Mio. Kanten und 1 Mio. Punkten. Dies muss für einen späteren
Export stark reduziert werden, um eine adäquate Darstellung in VRML zu gewährlei-
sten. Ein weiteres Kriterium war, dass die Wege, die den inneren Park durchziehen,
ein eigenständiges Objekt bilden sollen. Es soll möglich sein, diese unabhängig vom
Landschaftsmodell darzustellen. Eine Einhaltung von bestimmten Arbeitsschritten ist
notwendig, damit die Oberfläche des Landschaftsmodells und die Wege an den angren-
zenden Kanten, kongruent sind. Somit wurde erst die Oberfläche des TINs vereinfacht
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und anschließend die Wege als eigenständiges Objekt aus dem TIN gelöst. Eine umge-
kehrte Herangehensweise würde dazu führen, dass durch den Prozess der Dezimierung
beider separater Objekte, die Geometrie des Landschaft-TINs, und die der Wege un-
terschiedlich vereinfacht würde. Angrenzende Kanten wären nicht mehr deckungsgleich.
Dadurch entstünden unerwünschte Löcher zwischen der Landschaftsoberfläche und den
Wegen.

Zur Vereinfachung des TINs wird eine Funktion angewendet, die eine generalisierte
Version eines TINs in Abhängigkeit von einem Toleranzwert erzeugt. Der Toleranzwert
kann sowohl ein Intervall sein, innerhalb dessen Polygone zusammengefasst werden, als
auch eine Anzahl von Polygonen, die das generalisierte TIN maximal haben darf. Es
zeigte sich, dass die Eingabe eines Toleranzwertes, der ein definiertes Intervall bestimmt,
deutlich präziser arbeitet, als die zweite Auswahlmöglichkeit. Der zugrundeliegende Al-
gorithmus arbeitet so, dass jeder Punkt des Ausgangs-TINs, der mittels linearer In-
terpolation mit dem neuen TIN verglichen wird, nicht stärker als dieser Toleranzwert
abweicht. Nach einigen Tests erwies sich das Intervall von 10 cm als hinreichend gering,
um möglichst viele Informationen zu behalten und dennoch als ausreichend, um das
TIN weitestgehend zu vereinfachen. Dabei wurde der Prozess der Dezimierung mehr-
mals durchgeführt.

ArcToolbox -> 3D Analyst Tools -> TIN Surface -> Deciamte TIN Nodes

ZTolerance: 0,1

Copy Breaklines

Nach mehreren Durchgängen, verringerte sich die Anzahl der Polygone nur noch gering-
fügig. An dieser Stelle ist eine Grenze erreicht, an der, in dem spezifizierten Intervall,
keine Vereinfachung mehr möglich ist. Nachdem das TIN vereinfacht wurde besteht es
nun aus ca. 90.000 Polygonen, 270.000 Kanten und 45.000 Punkten.

(a) Das Gelände-TIN vor der Dezi-
mierung

(b) Das Gelände-TIN nach der Dezi-
mierung

Abbildung 6.10: Das Gelände-TIN vor und nach der Dezimierung
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6.2.1.4 Die Wege

Als abschließender Schritt wird das Herauslösen der Wege beschrieben. Ähnlich, wie bei
vorangegangenen Arbeitsschritten, diente dabei ein selbst erzeugtes Shapefile als Basis.
Da die Wege eine sehr komplexe Form beschreiben, und sie sich an vielen Stellen kreu-
zen, konnte bei der Erstellung der Form kein Polygon-Shape genutzt werden. Es wäre
an dieser Stelle mit Polygonen nur möglich gewesen, ein Negativ der Wege des Parks
darzustellen. Um die Form der Wege in ArcGis zu beschreiben, wurde ein Line-Shape
benutzt. Nachdem es in ArcCatalog erzeugt wurde, konnte es in ArcMap bearbeitet wer-
den. Höhenwerte waren für dieses Shapefile nicht relevant, da die Höhen später von der
Oberfläche des Gelände-TINs übernommen wurden. Die Grundlage für die Wege bildete
auch hierbei die CAD-Karte, in der alle Wege verzeichnet sind. Im Gegensatz zu einem
Polygon-Shape ist es bei der Bearbeitung des Shapefiles nicht ausschlaggebend, ob sich
Linien kreuzen. Das Line-Shape wurde so erzeugt, dass die Linien mittig auf den zu-
grundeliegenden Wegen verlaufen, mit dem Ziel, sie nach abgeschlossener Bearbeitung
zu puffern. Abschnitte, an denen Brücken stehen, wurden bei der Erstellung der Linien
mit einbezogen. Dadurch gehen die Wege an diesen Stellen später im Landschafts-TIN
durch das Flussbett, was real nicht der Fall ist. Derartige Mängel wurden an dieser Stelle
ignoriert und später im 3D-Modeller bearbeitet. Die erzeugten Linien dürfen dabei die
definierte Parkgrenze nicht überschreiten, da es sonst im späteren Verlauf nicht möglich
ist, das Modell zu exportieren. Der Grund dafür konnte nicht ermittelt werden. Eine
Vermutung ist, dass durch die Wege, die später extrahiert wurden, und damit ein eigen-
ständiges Objekt bilden, die Hülle des TINs aufgebrochen wird und dadurch kein Export
möglich ist. Aus der CAD-Karte ist ersichtlich, dass die Breite der Wege ca. 2,5 m im
Durchschnitt beträgt. Das erzeugte Line-Shape bildet die Ausgangsform für ein Polygon,
das die Wege darstellt. Da die Linie selber keine seitliche Ausdehnung besitzt, wird sie
an beiden Seiten um 1,25 m gepuffert.

ArcToolbox -> Analysis Tools -> Proximity -> Buffer

Distance: 1,25

Es entsteht ein Polygon-Shape, dessen symbolisierte Wege eine Breite von 2,5 m haben.
Da dieser Wert nur der Durchschnitt ist, entspricht das Polygon nicht allen Bereichen
im realen Park. Das machte es nötig, in betroffenen Abschnitten die Punkte des Wege-
Polygon-Shapes im Anschluss manuell zu bearbeiten. Vor allem im Areal des Schlosses
und des Gewächshauses ist die Form der Wege gänzlich verschieden und bedarf einer
Anpassung. Dazu werden einzelne Punkte des Wege-Polygon-Shapes manuell bearbeitet.

Im Editor den ’Task ’zu ’Modify’ wechseln

Mit dem endgültigen Wege-Polygon-Shape können die Wege aus dem TIN extrahiert
werden. Dazu sind zwei Operationen nötig. Die erste schneidet die Wege mit Hilfe der
erzeugten Schablone aus und die zweite erstellt aus ihr ein eigenständiges TIN, das
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die Wege repräsentiert. Es fügt die vorher ausgeschnittenen Wege als eigenständiges
TIN wieder ein, und die Höhen werden an betreffenden Stellen automatisch aus dem
Gelände-TIN übernommen. Die Reihenfolge dieser Operationen ist vernachlässigbar, da
jeweils gleiche Resultate erzeugt werden. Es wurde hier zuerst die Form der Wege aus
dem bestehenden TIN gelöst.

ArcScene -> 3D Analyst -> Create/Modify TIN -> Add Features to TIN

Das Wege-Polygon-Shape geht mit folgenden Optionen in die Triangulation des Gelände-
TINs ein:

Height source: <None>
Triangulate as: hard erase
Tag value field: <None>

Anschließend wird aus dem Wege-Polygon-Shape mit Hilfe des Gelände-TINs ein ei-
genständiges Wege-TIN erzeugt.

ArcScene -> 3D Analyst -> Create/Modify TIN -> Add Features to TIN

Das Polygon-Shape geht mit folgenden Optionen in die Triangulation des TINs ein:

Height source: <None>
Triangulate as: hard clip
Tag value field: <None>

(a) Ausschnitt des Wege-TINs (b) Ausschnitt des Gelände-TINs nach
Extrahierung der Wege

Abbildung 6.11: Das Gelände-TIN und die herausgelösten Wege

Die Funktionen und Möglichkeiten in ArcGIS, die einzelnen Objekte für eine Darstel-
lung in VRML zu optimieren, sind an dieser Stelle weitestgehend ausgeschöpft. Für den
weiteren Prozess ist es aber relevant die Geländeoberfläche weiter zu bearbeiten. Es sind
zum einen die Treppeneffekte, die nicht ohne weiteren Mehraufwand in ArcGIS bear-
beiten werden können. Zum anderen ist die Datengröße für eine Darstellung in VRML
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noch zu groß. Im Zuge weiterer Vereinfachung würden durch die begrenzten Funktion
von ArcGIS zu viele wichtige Informationen verloren gehen.

Bei dem Export der einzelnen Objekte ist es wichtig, dass alle Daten, die später eine
VRML-Welt darstellen, in ArcScene geladen sind. Einzelne Objekte werden so expor-
tiert, dass der Mittelpunkt der Geometrie des Objektes in der VRML-Welt auf dem
Koordinatenursprung liegt. ArcScene ermittelt die Koordinaten eines Objekts für den
Export in das VRML-Format anhand aller geladenen Objekte. Dabei wird die Position,
der zu exportierenden Objekte, ausgehend vom Szenen-Mittelpunkt aller geladenen Ob-
jekte, bestimmt. Durch die unterschiedliche Größe und Ausdehnung der einzelnen TINs
ermittelt ArcScene für jedes Einzelobjekt eine andere Position. Dadurch würden Objekte
in falscher Relation zueinander exportiert und ergäben eine falsche Darstellung in der
endgültigen VRML-Szene. Das heißt, für den Export aller bis jetzt erstellten Objekte, ist
es nötig alle Daten in ArcScene zu laden, und die einzelnen Objekte für einen Export zu
selektieren und die anderen zu deselektieren. Alle in ArcGIS erzeugten Objekte werden
aus ArcScene als VRML wie folgt exportiert.

ArcScene -> File -> Export Scene -> 3D

6.2.2 Bearbeitung des Geländes mit Maya

Nachdem die Objekte in ArcGIS fertiggestellt und exportiert wurden, war es nun mög-
lich, diese in Maya zu importieren. Maya bietet keine Möglichkeit direkt innerhalb des
Programms die VRML–Dateien zu importieren, stellt jedoch ein Tool bereit, mit dem
der Import möglich ist. Das Tool, ’wrl2ma.exe’, befindet sich im Ordner ’bin’ des Instal-
lationsverzeichnisses. Damit werden die einzelnen Objekte nacheinander in das Maya–
ASCII(.ma) Dateiformat, ein lesbares Format für Maya, gebracht. Die entstanden Datei-
en können nun problemlos in Maya in eine Szene geladen werden. Dabei haben sie nach
wie vor zueinander die jeweils korrekte Position im Raum.

File -> Import

Als erstes wurden Geländeoberfläche und Wege bearbeitet. Im Vordergrund stand die
Vereinfachung der Geometrie und damit die Reduzierung der Datengröße. Nach dem
Laden in Maya bestand die Geländeoberfläche aus ca. 90.000 Polygonen. Maya bietet
hierfür eine Funktion, die die Geometrie eines Polygons um einen bestimmten Prozent-
wert vereinfacht. Diese ist ähnlich zu der Funktion in ArcGIS, arbeitet jedoch genauer
und erzeugt weit bessere Ergebnisse. Durch die Vereinfachung der Geometrie wurden
auch die erwähnten Treppeneffekte stark reduziert.
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Edit Mesh -> Reduce

Reduce by: x

Keep: Mesh Boarders
Hard Edges

Der Prozess der Dezimierung wurde mehrmals mit kleineren Werten durchlaufen. So
konnte besser auf die Reduzierung eingegangen werden und eventuell entstandene Fehler
oder Unzulänglichkeiten in der Geometrie wurden schon frühzeitig erkannt. Der Wert
der Reduzierung wurde nicht statisch festgelegt, sondern vielmehr experimentell in je-
dem Durchgang ermittelt und geändert. Die Vorgehensweise stützte sich in Bezug auf
die Optimierung der Darstellung nur auf Beobachtungen und den subjektiven Eindruck.
Da die Landschaft und die Wege zusammen die Oberfläche des Geländes repräsentieren,
war es nötig, beide in dem Prozess der Dezimierung zu berücksichtigen. Weil diese aber
zwei unterschiedliche Objekte darstellen, werden sie auch so behandelt und dezimiert.
Die Funktion in Maya behandelt immer nur ein Polygon gleichzeitig und nimmt dabei
keine Rücksicht auf eventuell angrenzende Objekte. Auch die Vereinigung der beiden
Objekte, war nicht möglich, da sonst im Verlauf der Dezimierung die Geometrie der
Wege im Gelände als solches unkenntlich wird. Das Problem ist an dieser Stelle unum-
gänglich und es wurden Landschaft und Wege separat vereinfacht. Das heißt, nach dem
ersten Durchlauf der Reduzierung der Landschaft, wichen deren Kanten von denen der
Wege ab. Es entstanden Lücken in der Oberfläche. Die Komplexität der Geometrie wur-
de schrittweise bei beiden Objekten reduziert, bis das Gelände eine Polygonanzahl von
15.000 und die Wege von 3.500 aufwiesen. Mit dieser Größe der Daten war es möglich
ein VRML-Modell der Landschaft zu erzeugen, das adäquate Ladezeiten und eine gute
Navigation gewährleistete.

Um vorher genannte Defizite auszugleichen, musste das Modell nun manuell bearbei-
tet werden. Dieses sollte an einem Punkt geschehen, an dem die Anzahl der Polygone
nicht weiter durch Funktionen reduziert werden soll. Um die entstandenen Lücken zwi-
schen Gelände und Wegen zu schließen, wurden jeweils ein Punkt der Landschaft und
ein Punkt des Weges, die nahe beieinander lagen, zu ihrem gemeinsamen Mittelpunkt
vereint. Das geschah mit allen Punkten entlang der Kante, an dem das Wege-TIN aus
dem Landschafts-TIN gelöst wurde. Dabei blieben die einzelnen Punkte bestehen, teil-
ten sich aber die selbe Position im Raum. Somit waren die Lücken in der Oberfläche
geschlossen, da die Kanten beider Objekte wieder kongruent waren.

Edit Mesh -> Merge To Center

Da der Grund der Seen und Flüsse im fertigen Modell von Wasser bedeckt sein wird,
wurde entschieden, die Polygone, die den Grund repräsentieren, auszuschneiden, um so
nochmals die Geometrie zu reduzieren. Auch die Fehldarstellung der Wege, die vorher
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durch das Flussbett verliefen, konnte damit beseitigt werden. In einer Seitenansicht auf
das Modell wurde eine Schnittkante definiert, die das Polygon zerschnitt.

Edit Mesh -> Cut Faces Tool

Anschließend erfolgte Feinarbeit am Geländemodell. Noch bestehende Treppeneffekte
sowie unnatürlich aussehende Geometrien wurden durch gezielte Manipulation einzel-
ner Punkte beseitigt, und ein einfaches Polygon eingefügt, das das Wasser im Modell
repräsentiert.

Durch die Reduzierung der Polygone auf ein Minimum, beschreiben wenige Polygone
mitunter geometrisch komplexe Objekte der Landschaft. Das macht die Oberfläche starr
und kantig. (Abb. 6.12 a) Eine Möglichkeit, um das zu umgehen, wäre wieder Polygone
einzufügen, um die Struktur der Oberfläche zu glätten. Da jedoch das Ziel war, so wenig
wie möglich Polygone in dem VRML-Modell zu haben, wurde auf eine andere Variante
zurückgegriffen. Um eine glatte und weiche Oberfläche zu erhalten, mussten die Nor-
malenvektoren der einzelnen Punkte, die die Polygone definieren, verändert werden. Die
Normalenvektoren bestimmen die Reflektierung des Lichts und beeinflussen das Ausse-
hen der Polygone. Standardmäßig sind die Normalenvektoren in einem Winkel von 90◦

zur Polygonoberfläche definiert. Maya bietet hierfür eine Funktion, die die Normalen-
vektoren in Abhängigkeit von den angrenzenden Polygonen verändert. Um sie für einen
Punkt anzupassen, wurde ein Mittelwert der Normalenvektoren, der Flächen aller Poly-
gone in der ein Punkt liegt, durch Maya berechnet. Dieser wurde anschließend diesem
Punkt zugewiesen und gilt für alle angrenzenden Polygone an dieser Stelle. Somit ent-
stand der Eindruck einer glatten Oberfläche, obwohl das zugrundeliegende Objekt kantig
war.

Normals -> Average Normals

Diese Funktion wurde auch auf die anderen importierten Objekte, wie die Pyramiden
und die Inseln, angewandt.

6.2.3 Einfügen von Gebäuden

Zur Realisierung des Branitzer Parks, als virtuell begehbares Modell, gehören, neben
der Darstellung der Landschaft, auch die Gebäude, die den Park ergänzen. Vor allem
das Schloss, als bekanntestes Gebäude im Park, sowie die umliegenden Gebäude wie
Marstall und Kavaliershaus, sind für die Darstellung in einem Modell essentiell. Da der
Park von Flüssen und Seen durchzogen ist, sind die zahlreichen Brücken wichtig, um den
gesamten Park zu erschließen. Diese sollen auch als Objekte in die VRML-Welt einfließen.
Weiterhin bekannte Gebäude sind die Schmiede im Osten des Parks, das Torhaus im
Norden und die unmittelbar in der Nähe gelegene Gärtnerei, die ebenso Bestandteile des
VRML-Modells werden sollen.

Einige Gebäudemodelle, darunter das Schloss und umgebende Bauten, sowie einige
andere Bauwerke im Park, wurden vom Systemhaus Stahr schon im Rahmen der Visua-
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(a) Ausschnitt der Oberfläche des Modells
am Hermannsberg

(b) Der selbe Ausschnitt: nachdem die
Normalenvektoren bearbeitet wurden, hat
das Gelände eine weiche und kontinuierli-
che Oberfläche

Abbildung 6.12: Die Oberfläche des Modells vor und nach der Bearbeitung der Norma-
lenvektoren

lisierung des Branitzer Parks, als hochpolygonale Objekte erstellt und für dieses Projekt
zur Verfügung gestellt. Ebenso, wie in Kapitel 6.2.2 beschrieben, müssen diese Modelle
vom VRML-Format in ein für Maya lesbares Dateiformat gebracht werden. Das Schloss,
der Marstall, das Kavaliershaus, die Pergola mit den angrenzenden Mauern, die ägypti-
sche Brücke, das Podest auf der Landypramide, und das Parisol wurden in dieser Weise
bearbeitet und in Maya importiert. Noch nicht vorhandene Modelle wurden im Rah-
men dieser Arbeit mit Maya erzeugt. Dazu zählen die Schmiede, die Gärtnerei, das
Torhaus und die zahlreichen Brücken. Alle Modelle bestehen aus geometrischen Primiti-
ven. Hauptsächlich wurde der Kubus verwendet, um die genannten Objekte ”nachzubau-
en”. Dabei wurde darauf geachtet, dass entstehende Modelle in ihrer Komplexität nicht
100%ig der Realität entsprechen, sondern vielmehr vereinfachte Modelle repräsentieren
sollen, mit der Prämisse, diese adäquat in VRML darstellen zu können. An dieser Stelle
soll nicht genau auf den Prozess der Modellierung eingegangen werden, da er einerseits
kein Kernthema dieser Arbeit darstellt, und andererseits in jedem Programm auf eine
andere Art und Weise erfolgt. Am Beispiel einer Brücke soll die Modellierung in Maya
nur skizzenhaft angedeutet werden. (Abb. 6.13) Als Vorlage dienten hierbei nur Fotos,
aufgenommen aus verschiedenen Perspektiven.

Unter der Berücksichtigung des Ansatzes, Objekte mit gleichem Aussehen zu Einem
zu kombinieren (Kap. 4.2), wurden Teile mit gleichem Material zu einem zusammen-
geführt. Besonders bei dem Geländer, das durch viele einzelne geometrische Primitive
repräsentiert wird, wurde dieses Verfahren angewandt.

Mesh -> Combine

Die erzeugten Modelle wurden anschließend in die bestehende Maya-Szenerie impor-
tiert und mit Hilfe einer Referenz positioniert. Die Referenz, in ArcGIS erzeugt, zeigt
Standpunkte von Gebäuden als polygonale Flächen. Abgeleitet von der CAD-Karte wur-
den diese in ArcMap erzeugt und als VRML-Objekt exportiert, danach konvertiert und
in Maya geladen. Damit war es möglich, die Gebäude im Modell genau zu platzieren
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(a) Als erstes wurde eine Lauffläche als
Grundlage erstellt. Dafür diente ein Ku-
bus, der in entsprechende Form gebracht
wird.

(b) Da die meisten Brücken im Park auf
Stützen oder Pfeiler ruhen, wurden die-
se auch aus Kuben erzeugt, und relativ
zur Grundfläche in die richtige Position
gebracht

(c) Träger, die die Grundfläche der
Brücke stärken, wurden wie zuvor aus ei-
nem geometrischen Primitiv erzeugt und
unterhalb der Lauffläche platziert.

(d) Das Geländer stellte den letzten Teil
der Brücke dar. Es wurde aus verschiede-
nen skalierten Kuben zusammengesetzt,
die räumlich zu einander angeordnet sind.
Nachdem die einzelnen Teile erstellt wur-
den, ist die Form der Brücke komplett

(e) Den einzelnen Objekten wie Geländer, Grundfläche und
Stützen konnten nun unterschiedliche Materialien zugewiesen
werden.

Abbildung 6.13: Erstellung einer Brücke in Maya
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und zu skalieren, und im weiteren Verlauf räumlich korrekt zueinander für VRML zu
exportieren.

Im Hinblick auf die Realisierung für VRML und unter Berücksichtigung der Kriterien
aus Kapitel 4.2, war die Erzeugung einfacher Modelle aus schon Bestehenden, ein wei-
terer Schritt. Zugrunde liegt hierbei die Überlegung, dass Objekte in weiter Entfernung
weniger detailliert dargestellt werden müssen, als nahe liegende Objekte. Dafür wird
ein Grenzwert bestimmt, der von keinem der Gebäude überschritten werden soll. Dieser
wurde subjektiv festgelegt und beträgt ca. 4.000 Polygone pro Gebäude. Hochpolygonale
Objekte, wie das Schloss mit über 80.000 Polygonen, das Kavaliershaus mit ca. 5.000
Polygonen und der Marstall mit ca. 8.000 Polygonen wurden vorranging vereinfacht. Der
Marstall und das Kavaliershaus wurden mit der selben Funktion vereinfacht, die auch
bei der Oberfläche der Landschaft zur Anwendung kam.

Edit Mesh -> Reduce

Nach dem mehrmaligen Durchlaufen dieser Funktion, wurde die Anzahl der Polygone
dieser Gebäude auf 1/10 des Ausgangswerts reduziert.

Die Geometrie des Schlosses hingegen konnte nicht ohne weiteres vereinfacht werden.
Das hatte einerseits mit der Art der komplexen Geometrie und der Art der Konstruktion
zu tun, andererseits mit den Texturen, die über das Objekt drapiert waren. Die Positio-
nen der Texturen waren an die Geometrie des Modells gebunden. Bei dem Versuch, die
Geometrie zu vereinfachen, verschoben sich die Texturen und ergaben ein unbrauchbares
Modell. Hier wurde ein komplett neues, vereinfachtes Modell erstellt.

Ebenso, wie bei den hochpolygonalen Objekten, wurden die entstanden Gebäude in
die bestehende Szene importiert und an entsprechenden Stellen positioniert.

6.2.4 Exemplarisches Einsetzen von Bäumen

6.2.4.1 Bestimmung der Baumstandpunkte aufgrund von Sichtachsen

Im Branitzer Park gibt es ca. 8.000 Bäume, die in über 70 unterschiedliche Gattungen
untergliedert sind. Sie bilden ein Hauptgestaltungsmittel, das Pückler einsetzte, um ge-
zielt Bereiche zu verdecken, aber auch spezielle Sichten zu erzeugen. Es sollen im weiteren
Verlauf, auf der Grundlage von Sichtachsen, Bäume exemplarisch in die VRML-Welt ein-
gefügt werden. Dabei ist es nicht notwendig, alle Bäume in das Modell zu übernehmen,
sondern eine intelligente Auswahl, aufgrund von Sichtachsen, zu treffen. Es soll nur ein
Ausschnitt des kompletten Baumrepertoires des Branitzer Parks in die Darstellung ein-
gehen. Dabei handelt es sich in erster Linie um die am meisten vorhandenen Bäume im
Park, aber auch um solche, die innerhalb einer Sicht dominieren, und diese prägen. Das
hat den Grund, dass auch in der späteren Darstellung, Bäume mit gleicher Erscheinung
nur durch ein Baummodell realisiert werden sollen. Baumgattungen sollen verallgemei-
nert und zu einer Repräsentation eines Baums zusammengefasst werden. Es soll sich
aber so nah wie möglich an der Realität orientiert werden und Verallgemeinerungen nur
in einem vertretbaren Rahmen stattfinden.
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Die Darstellung der Bäume in der VRML-Welt setzt sich aus den Standpunkten, die
innerhalb ArcGIS ermittelt und exportiert werden, und aus einem in Maya erzeugten
einfachen Baummodell zusammen. Es erfolgt hier kein Export von ArcGIS in Maya und
anschließend in VRML, wie es bisher der Fall war, sondern beide Teile vereinen sich erst
bei der Erstellung der VRML-Welt.

Visualisierung der Bäume des Parks

Um zu bestimmen, welche Bäume für eine weitere Bearbeitung und Darstellung rele-
vant sind, galt es zu ermitteln, ob diese von einem bestimmten Standpunkt aus sichtbar
sind. Dazu mussten zu aller erst Sichten bestimmt werden. Zwei wurden dafür festgelegt.
Es handelt sich um den Blick vom Hermannsberg auf die Pyramiden und die Sicht von
dem kleinen Hügel auf das Schloss samt Marstall und Kavaliershaus. Der Grund für diese
Auswahl ist die Möglichkeit, diese Sichten mit den fiktiven, sowie historischen Modellen
zu vergleichen. In diesem Kapitel soll die Sicht vom Hermannsberg auf die Pyramiden
als Grundlage für eine weitere Beschreibung dienen. Der angeführte Arbeitsvorgang ist
dabei auf jede andere übertragbar.

Mit den definierten Sichtachsen ist es möglich, in ArcScene andeutungsweise darzustel-
len, welche Bäume für eine Sicht relevant sind. Durch die Möglichkeit, sich in ArcScene
innerhalb einer Szene frei zu bewegen und zu navigieren, ist es möglich, erste Schlüsse
zu ziehen, welche Gebiete von einer Sicht aus zu sehen sind, und damit verbunden, Bäu-
me zu selektieren, die relevant sind, um eine realitätsnahe Darstellung der VRML-Welt
zu bekommen. Das bereits erzeugte GIS-bezogene Material bildet dabei die Grundlage
und wird in ArcScene geladen. Dazu gehören das Gelände, die Wege, die Inseln und die
beiden Pyramiden.

Um die Position der einzelnen Bäume des inneren Parks zu beschreiben, dient ein
Shapefile, das sogenannte Baumkataster. Dieses stellt anhand von Punkten die exakte
Position der Bäume dar, und beinhaltet zusätzliche Daten wie: Gattung der Bäume,
deutsche Bezeichnung, Höhe, Stammumfang, Kronendurchmesser, Vitalität der Bäume
etc. Das Baumkataster beschreibt nur die Lage der Bäume, besitzt jedoch keine ver-
wendbare Höheninformation der Punkte. Für eine Visualisierung mussten ihnen, anhand
des Gelände-TINs, noch Höhen zugeordnet werden. Jeder Punkt des Baumkatasters be-
kommt so die Höhe, die das TIN an betreffender Stelle aufweist.

ArcScene -> Rechtsklick auf das Baumkataster -> Properties -> Reiter ’Base Heights’
-> ’Obtain heights for layer from surface’

Anschließend werden die Punkte auf der Geländeoberfläche dargestellt. In ArcScene
ist es möglich, die Repräsentation der Standpunkte der Bäume mittels simpler Punkte
durch Baum-Symbole zu ersetzen. Das erlaubt dem Betrachter einen Eindruck davon zu
bekommen, welche Areale in eine Sicht involviert sind und welche überdeckt werden. Zur
Darstellung dieser Punkte als Bäume muss folgende Einstellung vorgenommen werden.

ArcScene -> Rechtsklick auf das Baumkataster -> Properties -> Reiter ’Symbology’
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Es erscheint ein Menü, in dem mehrere Baumarten zur Verfügung stehen. Um einen rea-
litätsnahen visuellen Eindruck zu bekommen, wurde für die Repräsentation aller Bäume
ein einheitliches Baumsymbol verwendet, dem eine Höhe von 20 m zugewiesen wurde.
Dieses, senkrecht auf dem TIN stehende Symbol, wird dabei durch zwei zueinander recht-
winklige Flächen mit jeweils einer Baumtextur dargestellt.

Auswahl der Baumgruppen

Durch die Navigation der Kamera, an den zuvor festgelegten Sichtpunkt, war es möglich,
relativ genau abzuleiten, welche Areale relevant sind, um ein realitätsnahes Modell zur
erzeugen. Es ließen sich Schlüsse daraus ziehen, welche Bäume von anderen überdeckt
werden, und welche Baumstandpunkte übernommen werden mussten, um eine adäquate
Sicht in der VRML-Welt zu erhalten. (Abb. 6.14) Um die benötigten Punkte aus dem

Abbildung 6.14: Der Blick vom Hermannsberg in ArcScene

Baumkataster zu extrahieren, wurde ein Polygon-Shape erzeugt, was die vorher ermit-
telten relevanten Standpunkte der Bäume eingrenzte. Dieses diente als Schablone, die
ein Gebiet aufzeigt, in welchem alle, für die Nachempfindung der Sicht, relevanten Bäu-
me stehen. Anhand der Visualisierung in ArcGIS ist ersichtlich, dass es nicht notwendig
ist, alle Bäume zu visualisieren. Auch wenn sie innerhalb des Sichtkegels des Betrach-
ters wären, werden sie von anderen überdeckt. Baumstandpunkte, die ausgehend vom
Sichtpunkt nicht sichtbar sind, wurden deshalb in der Erstellung des Polygons nicht
berücksichtigt. Das Polygon wurde, wie in Kapitel 6.1 beschrieben, erzeugt. Mit seiner
Hilfe war es möglich, die relevanten Standpunkte der Bäume zu extrahieren. Sie sind
innerhalb der Sicht notwendig, um ein reales Modell zu kreieren. Dabei wurden Punkte,
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die innerhalb der Grenzen des Polygons liegen, ausgeschnitten. Sie bilden ein eigenstän-
diges Shapefile.

Toolbox -> Analysis Tools -> Extract -> Clip

Es entstand ein Baumkataster mit der flächenmäßigen Ausdehnung des Polygons. Das er-
zeugte Baumkataster beinhaltete nun weit weniger Baumstandpunkte als das komplette
Baumkataster, jedoch für eine spätere Darstellung weiterhin zu viele.

Wie in diesem Kapitel schon erwähnt, sollen nur die am meisten vertretenen Bäume
in Abhängigkeit einer Sichtachse, sowie die, die signifikant für eine Sicht sind, weiterhin
betrachtet werden. Aufgrund der Tatsache, dass in ArcGIS Daten innerhalb einer Da-
tenbank verwaltet werden, ist es möglich, Abfragen durchzuführen. Somit kann aus dem
entstanden Baumkataster abgefragt werden, welche Bäume häufiger und welche weniger
häufig vorkommen. Anhand dieser Möglichkeit, einen Datensatz auszuwerten, konnte
bestimmt werden, welche Baumarten in einer Sicht dominieren. Um einen Datensatz
auszuwerten, müssen in ArcGIS innerhalb einer Funktion die Attribute ausgewählt, und
die Art der Statistik bestimmt werden. In diesem Fall ist das die Anzahl der Bäume
einer Gattung.

Toolbox -> Analysis Tools -> Statistics -> Summary

Für die Sichtachse vom Hermanssberg ist das die Eiche und die Buche. Dabei wur-
den bei der Auswertung jeweils für beide Bäume alle Gattungen dieses Baumes zu einer
Baumgruppe zusammengefasst. Das heißt, unter dem Begriff ’Eiche’ vereinen sich Ro-
teiche, Stieleiche, Sumpfeiche und Säuleneiche. Weiterhin sind für die VRML-Welt nur
Bäume relevant, die eine gewisse Höhe besitzen. Anhand von Auswertungen wurde er-
mittelt, dass die Bäume in bestimmten Höhenintervallen häufiger vertreten sind. Für die
Eiche ist es ein Intervall von 20-24 m und 26-27 m, für die Buche 14-15 m und 20-24 m.
In der fertigen Darstellung wird dann ein Baum der Baumgruppe, der alle Gattungen
der Eiche repräsentiert und eine Höhe von 20-24 m besitzt, durch ein einziges Modell
beschrieben. Genauso verhält es sich mit der Buche.

Anhand dieser ermittelten Fakten konnten betreffende Baumstandpunkte, die eine
Baumgruppe repräsentieren, separiert werden. Jede Baumart mit entsprechendem Hö-
henintervall bildete dann ein neues Baumkataster. Dazu wurden als erstes die Punkte
mit Hilfe von SQL3-Abfragen selektiert. Durch die Abfrage werden nur die Punkte ge-
zeigt, die der WHERE–Klausel des SQL-Statements entsprechen. Alle anderen werden
nicht dargestellt. Sie existieren aber in diesem Datensatz weiterhin.

ArcScene -> Rechtsklick auf Baumkataster -> Properties -> Reiter: ’Definition Que-
ry’

3SQL, Abkürzung für Structured Query Language, ist eine Sprache zur Definition, Abfrage und Mani-
pulation von Daten in relationalen Datenbanken
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Die WHERE-Klausel in Abbildung 6.15 selektiert nur alle Gattungen der Eiche, die
zwischen 20 und 24 m hoch sind: Nachdem nur alle betreffenden Punkte sichtbar sind,

’ ’DEUTSCHE B ’ ’ = ’ Rote iche ’
OR ’ ’DEUTSCHE B ’ ’ = ’ S t i e l e i c h e ’
OR ’ ’DEUTSCHE B ’ ’ = ’ Sumpfeiche ’
OR ’ ’DEUTSCHE B ’ ’ = ’ S äu l ene i che ’
AND ’ ’HöHE M’ ’ >= ’ 20 ’ AND ’ ’HöHE M’ ’ <= ’ 24 ’

Abbildung 6.15: SQL-Abfrage

musste daraus eine neue Datei erzeugt werden, die tatsächlich auch nur diese Werte ent-
hält.

ArcScene -> Rechtsklick auf Baumkataster -> Data -> Export Data

Der Vorgang wurde für alle wiederholt, und es entstanden vier neue Shapefiles, die jeweils
eine Baumgruppe mit dem jeweiligen Höhenintervall beschreiben.

Weiterhin signifikant für die Sicht vom Hermansberg waren die Nadelbäume, die in
dieser Perspektive im Vordergrund stark vertreten sind. Besonders dominant in diesem
Gebiet sind Kiefern, Tannen, Fichten und Lärchen. Diese Bäume stehen verhältnismä-
ßig nahe zum Sichtpunkt. Im Hinblick auf eine spätere Darstellung in VRML wurden,
aufgrund ihrer Erscheinung, Tanne und Fichte, sowie Kiefer und Lärche jeweils zu ei-
ner Baumgruppe zusammengefasst. Bei diesen Baumgruppen kamen selbige Schritte wie
bereits beschrieben zur Anwendung. Es entstanden zwei weitere Baumgruppen, die die
Nadelbäume repräsentieren. All diese erzeugten Point-Shapes beinhalten die Standpunk-
te der einzelnen Bäume einer Baumgruppe. Diese Daten wurden anschließend in das
VRML-Format exportiert, und die einzelnen Punkte wurden später verwendet, um die
Bäume an den räumlich exakten Standpunkten in die VRML-Welt einzubinden.

6.2.4.2 Erstellung von Baummodellen mit Maya

Alle Baumgruppen, die in Kapitel 6.2.4.1 für eine weitere Darstellung vorbereitet wurden,
werden in der VRML-Welt unterschiedliche Erscheinung haben. Um das zu erreichen, be-
darf es simpler Modelle, die alle Bäume einer Baumgruppe repräsentieren. Diese sollen in
der späteren VRML-Welt als Billboards eingesetzt werden, deren Standpunkte durch die
ermittelten Punkte beschrieben werden. Als Darstellungsform soll ein einfaches Rechteck
fungieren, auf das eine Textur gelegt wird, die den jeweiligen Baum darstellt.

Um Relationen und die Höhe der Bäume im Verhältnis zum Rest der VRML-Welt
beizubehalten, wurde zuerst für jeden Repräsentanten einer Baumgruppe eine Darstel-
lung in ArcScene erstellt. Für die Baumgruppe der Eiche zwischen 20-24 m wurde der
Mittelwert dieser Höhen genutzt. Dazu musste, wie in Kapitel 6.2.4.1 beschrieben, die
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Symbologie der Bäume von einem Punkt in einen Baum geändert werden. Anders, als in
dem Kapitel beschrieben, sollte hier aber ein einfaches Rechteck anstelle der gekreuzten
Rechtecke als Symbol dienen.

ArcScene -> Rechtsklick auf das Baumkataster -> Properties -> Reiter ’Symbology’

In dem Menü ’Properties’ den Eintrag bei ’Type’ von ’3D Character Marker Symbol’
auf ’3D Marker Symbol’ ändern.

Nun wurde die vorher bestimmte Höhe zugewiesen. In diesem Fall war das der Mit-
telwert von 20-24 m. Damit das Modell in das VRML-Format exportiert werden konnte,
musste es vorher in eine ’echte’ Geometrie umgewandelt werden, da sämtliche Bäume in
ArcScene nur als Symbol dargestellt werden.

ArcScene -> 3D Analyst Tools -> Conversion -> Layer 3D to Feature

Die in ArcScene dargestellte Repräsentation der Bäume wurde nun in ’echte’ Polygo-
ne umgewandelt. Dabei verlor das entstandene Modell die Textur, die in der Darstellung
in ArcScene noch zu sehen war. Das hat den Grund, dass die Texturen nur innerhalb
ArcGIS zu Visualisierungszwecken nutzbar, aber nicht für einen Export in ein anderes
Format vorgesehen sind. Die Modelle konnten nach dieser Operation exportiert werden.
Nach dem Konvertieren in das Maya-ASCII Format konnte das Modell in Maya weiter
bearbeitet werden. Da nur ein Repräsentant relevant ist, wurden alle bis auf diesen elimi-
niert. Anschließend konnte dieser in der Mitte des Koordinatensystems zentriert werden,
so dass die untere Kante des Objekts mittig auf dem Koordinatenursprung stand. Ei-
ne, dem jeweiligen Repräsentanten der Baumgruppe entsprechende Textur wurde dem
Objekt zugewiesen und abschließend in das VRML-Format exportiert.

Abbildung 6.16: Eine Baumdarstellung in Maya
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6.3 Erzeugung eines historischen Modells

6.3.1 Einarbeitung historischer Informationen in Teile des TINs

6.3.1.1 Gebietsauswahl

Anders als beim Modell, das den aktuellen Zustand darstellt, dient für ein historisches
Modell nur ein Ausschnitt des in Kapitel 6.1 erzeugten TINs. Begründet wird das durch
die Wahl des Zeitpunkts, zu dem das historische Modell dargestellt werden soll, und durch
das vorhandene Material, das diesem zugrunde liegt. Wie in Kapitel 3.2 erwähnt, sol-
len möglichst prägnante Veränderungen, die sich überwiegend auf vorhandenes Material
stützen, dargestellt werden. Für das historische Modell wurde das Jahr 1845 ausgewählt.
Interessant dabei ist es darzustellen, wie der Park aussah, bevor Pückler begann, ihn zu
gestalten. Zu dieser Zeit standen Häuser der Bauern um den Schwarzen See, und das
Schloss war von einem Graben umgeben. Der Park war noch nicht gestaltet. Maßgeblich
für diese die Wahl des historischen Zeitpunkts ist das GIS-bezogene Material und der
Vergleich von Sichten. Als Sichtachse dient diejenige, die auch im aktuellen Modell bei
der Erstellung berücksichtigt wurde: vom kleinen Hügel im Norden des Schlosses in Rich-
tung Süden auf das Schloss und umliegende Gebäude. Aufgrund dieser Informationen
ist es möglich, ein Gebiet einzugrenzen, das nur einen kleinen Ausschnitt des komplet-
ten heutigen Parkgebiets darstellt. Es umfasst den heutigen Pleasureground und einen
kleinen Teil des Dorfes Branitz.

Um betreffendes Areal aus dem bestehenden TIN herauszulösen, wurde ein Polygon-
Shape erzeugt, das den Teilbereich abdeckt. Dieses wurde als Schablone zur Erzeugung
eines TINs genutzt. Indem dieser betreffende Teil mit Hilfe des Polygons ausgeschnitten
wurde, entstand ein kleines TIN, das die Oberfläche des heutigem Parks widerspiegelt.
Das beinhaltet Kanäle, Seen und Erhebungen.

6.3.1.2 Nachbearbeitung des TINs

Aufgrund der geschichtlichen Aufzeichnungen und des GIS-bezogenen Materials war
es notwendig, die Oberfläche des TINs dementsprechend zu verändern. Ettrich [5] be-
schreibt, dass das heutige Parkareal vor der Gestaltung durch Pückler eine flache, sandige
Kiefernheide war. Die Gewässer und das Terrain hatten im Vergleich zu heute komplett
verschiedene Formen.

Kanäle und Erhebungen des TINs wurden deshalb mit Hilfe von Polygon-Shapes auf
ein annähernd gleiches Niveau angehoben, beziehungsweise abgesenkt. Die Erzeugung
und Einarbeitung der Polygon-Shapes in das TIN geschah auf selbe Weise, wie in Kapi-
tel 6.2.1.2 beschrieben. Das Terrain ist nach der Bearbeitung fast eben und weist kaum
noch Höhenunterschiede im Gelände auf. Dabei war es nicht möglich, aufgrund der hete-
rogenen Oberflächenbeschaffenheit, alle Unzulänglichkeiten mit Hilfe der Polygon-Shapes
zu beseitigen. Es entstanden Geländesprünge, die nur mit erheblichen Mehraufwand in
ArcGIS hätten beseitigt werden können. (Abb. 6.17) Diese sollen später im 3D-Modeller
bearbeitet werden. Flüsse und Seen, die zu Pücklers Zeit die Landschaft durchzogen,
sind durch GIS-Material belegt und definieren die räumliche Lage und Ausdehnung der
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Abbildung 6.17: Das historische TIN nach der Geländeveränderung. Im Bereich des
Schlosses und des Schilfsees sind Sprünge im Gelände zu erkennen.

Fließ- und Standgewässer. Analog der Arbeitsschritte in Kapitel 6.2.1.1 konnten mit Hil-
fe dieser Daten Uferkanten und ein Flussgrund definiert werden. Dabei wurde von den
selben Höhen ausgegangen, die auch im aktuellen TIN eingearbeitet sind. Für die Ufer-
kante sind das 72,6 m über NN und für den Wassergrund 71,8 m über NN. Die Höhen
wurden den Polygon-Shapes zugewiesen und anschließend als ’hard replace’ in das TIN
eingearbeitet. Nach dieser Bearbeitung hat das TIN eine Beschaffenheit, die sich mit
dem GIS-Material, sowie den geschichtlichen Überlieferungen weitestgehend vereinbaren
läßt.

6.3.1.3 Vereinfachung des Geländes

Analog zur Erzeugung des aktuellen TINs, musste auch dieses vereinfacht werden. (Kap.
6.2.1.3) Es war auch hier wichtig, die Reihenfolge der Vereinfachung des Geländes und
das Herauslösen der Wege einzuhalten. Da das TIN nur ein kleiner Teilbereich ist und
weniger Geometrie aufweist, wurde die Funktion der Dezimierung jedoch nur wenige
Male durchlaufen, da die gewünschte Anzahl an Polygonen schneller erreicht war. Nach
diesem Prozess bestand das TIN aus ca. 45.000, vorher aus ca. 730.000 Polygonen.

Anschließend wurden, wie beim TIN des aktuellen Parks, die Wege als eigenständige
Objekte aus dem TIN gelöst. Die Grundlage bildet das Polygon-Shape, das die Verkehrs-
wege um 1845 repräsentiert. Aus diesem wurde ein neues Polygon-Shape erzeugt, das die
räumliche Ausdehnung des TINs besitzt. Dazu musste das Polygon-Shape mit Hilfe der
definierten Grenze beschnitten werden. Damit der Export in das VRML-Format funk-
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tioniert, durfte das neu entstandene Polygon-Shape nicht die Grenzen des TINs über-
schreiten, beziehungsweise berühren. (Kap. 6.2.1.4) An den betreffenden Stellen wurden
einzelne Punkte nachbearbeitet und minimal verschoben. Mit diesem Polygon-Shape
ließen sich, analog zum aktuellen TIN, die Wege herauslösen und ein eigenständiges
Wege-TIN erzeugen. Dabei kamen die selben Schritte zur Anwendung die in Kapitel
6.2.1.4 beschrieben sind. Es entstanden Wege und Gelände, als eigenständige TINs. Sie
sind an den gemeinsamen Kanten kongruent. Beide konnten abschließend für eine weitere
Bearbeitung exportiert werden.

6.3.2 Bearbeitung des Geländes mit Maya

Nach dem Import der beiden Objekte in Maya folgten die selben Bearbeitungsschritte,
die auch bei der Erzeugung des aktuellen TINs zur Anwendung kamen. (Kap. 6.2.2)
Es wird deshalb im Folgenden nicht ausführlich darauf eingegangenen. Beide Objekte
wurden separat vereinfacht, bis die Geometrie auf 1/10 des Ausgangswerts reduziert
war. Dabei entstanden auch hierbei Lücken zwischen den beiden Objekten, da diese un-
terschiedlich vereinfacht wurden. Ausgeglichen wurde das durch manuelle Bearbeitung
und die Zusammenführung der Punkte der Wege und der Punkte des Terrains. An den
Stellen, wo Erhebungen und Kanäle mit Hilfe von Polygon-Shapes ausgeglichen wurden,
entstanden teilweise Geländesprünge. (Abb. 6.17) Diese konnten durch keine Funktion
innerhalb von ArcGIS oder Maya beseitigt werden und mussten durch gezielte Manipu-
lation der Punkte in Maya bearbeitet werden. Dabei wurde darauf geachtet, das Terrain
flach und eben zu gestalten. Abschließend wurden die Normalenvektoren der Polygone
des TINs verändert, um eine glatte und kontinuierliche Oberfläche zu erhalten.

6.3.3 Einfügen von Gebäuden in das Modell

Aufgrund der Beschreibung, dass um 1845 Bauernhäuser rund um den heutigen Schwar-
zen See standen, und dem GIS-Material, das die Standpunkte dieser genau bestimmt,
wurde auf diese Thematik besonderes Augenmerk gelegt. Um ein möglichst realitäts-
nahes historisches Modell zu erzeugen, wurde deshalb stark auf die Erscheinung dieser
Häuser geachtet. Das Aussehen, die Form und die Größe sind dabei die Merkmale, die
besonders berücksichtigt wurden.

Die Standpunkte der Häuser und des Schlosses sind durch ein Polygon-Shape als GIS-
Material definiert. Dieses wurde in das VRML-Format exportiert, für Maya konvertiert
und anschließend importiert. Sie zeigen, an welchen Stellen die Häuser sowie das Schloss
standen und welche flächenmäßige Ausdehnung diese besaßen. Wie die Häuser genau
aussahen und welche Höhe sie hatten, ist nicht überliefert. Die Höhen wurden deshalb
anhand von Relationen der einzelnen Polygone, die eine Hausfläche darstellen, bestimmt.
Die Form der Häuserdarstellung wurde weitestgehend aus dem VRML-Modell der Cott-
buser Altstadt von 1720 übernommen. Anhand dieser Informationen konnten die Grund-
formen für die einzelnen Häuser bestimmt werden. In Maya konnten einfache Häusermo-
delle erzeugt werden, die im Anschluss texturiert wurden. Das Systemhaus Stahr stellte
die Texturen für diese Modelle zur Verfügung. Sie sind überwiegend im JPEG-Format
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und zeigen Dächer und Häuser aus verschiedenen Ansichten. Dabei gibt es mehrere
Texturen von Dächern und drei grundlegende Texturen von Häusern: das Steinhaus,
das Fachwerkhaus und das Blockhaus, beziehungsweise eine einfache Holzhütte. Diese
drei Grundtypen bestehen in unterschiedlichen Ausführungen, und es wurden daraus 15
Häusermodelle in Maya erstellt. Dabei ist die Form des Hausmodells für alle die selbe, le-
diglich die Texturen wurden unterschiedlich zugewiesen. Eine Hauswand hat jeweils eine
Textur. Das bedeutet, dass bei einer rechteckigen Form des Hauses sechs (zwei Dächer
und vier Außenwände) Texturen das komplette Haus bedecken. Die Grundfläche wurde
vernachlässigt, da diese nicht zu sehen ist. Es hat sich gezeigt, dass die Vielzahl an ein-
zelnen Texturen erhebliche Performanceeinbrüche in der VRML-Darstellung verursacht.
Vor allem beim Laden der Szenerie ist es deutlich merkbar, dass die Ladezeit propor-
tional zu der Anzahl der Texturen wächst. Aus dem Grund wurden die Texturen, die
auf ein Haus drapiert sind, zu einer zusammengefasst. Dadurch reduzierte sich die größe
der Bilddatei und weniger Texturen müssen in den Speicher geladen werden. Auf den
Prozess der Erstellung der Texturen soll an dieser Stelle nicht eingegangen werden, da er
in jedem 3D-Modeller auf eine andere Weise erfolgt. Die Größe der Texturen reduzierte
sich nach diesem Prozess auf unter 1/10 der Ausgangsgröße. Die Platzierung einzelner
Häusermodelle stützte sich teilweise auf die, in Kapitel 3.2 beschriebenen Umbauarbeiten
im Park. Es ist angeführt, dass der Marstall von 1847 bis 1848 umgebaut wurde und vor-
her als Stall, Wagenremise und Wohnraum diente. Desweiteren zeigt das GIS-Material,
dass direkt an dem heutigen Marstall damals noch weitere Gebäude standen. Aus die-
sem Grund wurden Modelle, die Steinhäuser repräsentieren, an die Stelle des heutigen
Marstalls platziert und daneben Fachwerkhäuser, die Stall und Wagenremise andeuten
sollen. Obwohl keine schriftlichen Aufzeichnung vom Kavaliershaus vorlagen, war die
Verfahrensweise die selbe. Die Platzierung des Häusertyps auf die anderen Standorte
wurde überwiegend willkürlich vorgenommen, da darüber keine Informationen vorhan-
den waren. Um Sichten vergleichen zu können, wurden die Häusermodelle nur an den
Stellen platziert, die heute innerhalb der Parkgrenzen lägen. Häuser, die auf dem Gebiet
des heutigen Dorfes Branitz liegen, wurden vernachlässigt. Das hat einerseits den Grund,
dass von dem ausgewählten Sichtpunkt diese nicht mehr zu sehen sind, und andererseits
die Performancesteigerung der VRML-Welt.

Wie im Modell des aktuellen Parks sind Brücken und das Schloss auch in diesem
Modell essentielle Gebäude, zumal das Schloss zu dieser Zeit von einem Graben umgeben
war und ein Fließgewässer das Gebiet in der Mitte teilte. In der Graphitzeichnung von
Wilhelm Heinrich Masser ist das Schloss zu sehen, umgeben von einem Schlossgraben,
der von drei einfachen Brücken überspannt wird. Das Schloss liegt als hochpolygonales
sowie als vereinfachtes Modell vor, und konnte für die Darstellung des historischen Parks
übernommen werden. Es wurden die Terrasse entfernt und der Eingangsbereich, sowie die
Schornsteine anhand der Zeichnung verändert. Die Brücken scheinen auf dem Bild sehr
einfache Formen zu besitzen und wurden dementsprechend modelliert und anschließend
platziert. Dies geschah nach der Vorlage der Zeichnung und unterliegt keinen genauen
räumlichen Daten. Ebenso wurden die selben Brückenmodelle an verschiedenen Stellen
über dem Fließgewässer positioniert. Abschließend konnten alle Modelle in das VRML-
Format exportiert werden.
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6.3.4 Exemplarisches Einsetzen von Bäumen

Präzise Baumstandpunkte, die für das aktuelle Modell bekannt sind, waren für ein hi-
storisches Modell nicht vorhanden, weder als Karten- noch als GIS-Material. Um eine
möglichst exakte Nachbildung des historischen Parks zu erhalten, wurde sich deshalb
auf die Aufzeichnung von Ettrich [5] bezogen. Beschrieben ist das Gebiet als sandige,
ebene Kiefernheide. Auf der Graphitzeichnung von Wilhelm Heinrich Masser sind im
Vordergrund Nadelbäume zu sehen, die rund um das Schloss stehen. Erkennbar sind die
Standpunkte der Bäume und das ungefähre Aussehen. Dabei ist es aber nicht möglich,
abzuleiten, welche Nadelbaumart es genau ist. Weiteres Bildmaterial für diese Zeit war
nicht vorhanden. Das heißt, dass restliche Standpunkte von den Bäumen anhand von We-
gen und Bebauung bestimmt wurden. Da es nicht genau bekannt ist, welche Baumarten
zu dieser Zeit im Park standen, wurden, wie in Kapitel 6.2.4.2 beschrieben, in Maya zu-
vor drei Repräsentanten erzeugt, die verschiedene Nadelbäume darstellen. Diese Modelle
stellen zwei Varianten der Kiefer und eine der Tanne dar. Um die Standpunkte festzule-
gen, mussten drei Point-Shapes in ArcGIS erzeugt werden, die jeweils Standpunkte einer
Baumgruppe darstellen. Sie wurden anschließend in das VRML-Format exportiert.

6.4 Erzeugung eines Modells mit möglichen zukünftigen
Bebauungsszenarien

6.4.1 Erweiterung des Messegeländes

Unter dem Aspekt, Sichten aus unterschiedlichen Zeiten zu vergleichen, wurde für ein
mögliches Szenario die selbe Sichtachse gewählt, die auch bei der Erzeugung des aktuellen
Modells berücksichtigt wurde. Das ist die Sicht vom Hermannsberg auf die Pyramiden.
Für das Szenario gelten zwei Annahmen. Zum einen, dass eine Erweiterung des Messe-
geländes bis an den heutigen inneren Park im Norden reicht, und zum anderen, dass die
Architektur dem bereits bestehenden Messegebäude entspricht. Das Ziel dieses Szenarios
ist, zu untersuchen und zu zeigen, welche Gegebenheiten bei einer möglichen Erweiterung
des Messegeländes nötig sind, um die aktuelle Sicht vom Hermannsberg zu beeinflussen.
Dabei spielen die Höhe und die Standpunkte der Gebäude, sowie der Bäume im Park
eine gravierende Rolle. Die Grundlage für die spätere fiktive VRML-Welt bildeten dabei
die schon erzeugten GIS-Daten des heutigen Parks. Diese sollen durch eine Erweiterung
des Messegeländes ergänzt werden. Weiterhin soll eine Karte eingefügt werden, auf der
das umliegende Areal zu sehen ist. Weiterführende Arbeitsschritte, wie der Export in
VRML und die Bearbeitung in Maya, sind analog zu der Vorgehensweise beim aktuellen
Modell.

6.4.1.1 Position und Gestalt des Messegebäudes

Um die Position des ’neuen’ Messegebäudes zu bestimmen, diente das Raster, das alle
vier Teilbereiche darstellt.(Kap. 6.1) Da keinerlei Informationen vorliegen, die die exak-
ten Standpunkte möglicher Bebauung definieren, wurden an dieser Stelle Standpunkte
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gewählt. Sie befinden sich nahe am nordwestlichen Rand des inneren Parks. Analog
der Verfahrensweise in Kapitel 6.2.3 wurde für diesen Standpunkt ein Polygon-Shape
erzeugt, das die Lage des Gebäudes in Relation zum Park darstellt.

Für die Erweiterung des Messegeländes wurde vorerst von der selben Höhe der be-
reits bestehenden Gebäude ausgegangen. Da diese nicht bekannt waren, mussten sie
vorab ermittelt werden. Die DTM-Daten, die Grundlage für alle vorangegangen Modelle
waren, zeigen nur die Oberfläche des Terrains. Es war nicht abzuleiten, welche Höhe
Gebäude oder Bäume in dieser Sichtachse besitzen. Die Verwendung von DSM-Daten
kompensierten diese Defizite. Sie stellen die Erdoberfläche samt Bebauung und Vege-
tation dar. Höheninformationen der betreffenden Gebäude sind daraus leicht ableitbar.
Dazu mussten die selben Teilbereiche in ein für ArcGIS lesbares Format gebracht, und
anschließend zusammengeführt werden. (Kap. 6.1) Mit diesen Daten war es möglich, ein
Raster zu erstellen. Der Vergleich von Höhenwerten des Rasters, erzeugt aus DTM-Daten
und des Rasters erzeugt aus den DSM-Daten, gab Aufschluss auf die durchschnittliche
Höhe des Messegebäuedes. Die Differenz beträgt am höchsten Punkt des Gebäudes ca.
14 m. Entscheidend für eine Sichtbarkeit des Messegebäudes vom Hermannsberg sind
die Bäume entlang der Sichtachse. Um konkrete Aussagen treffen zu können, wurde eine
Sichtbarkeitsanalyse durchgeführt.

6.4.1.2 Sichtbarkeitsanalyse

Eine Sichtbarkeitsanalyse wurde anhand der zugrunde liegenden Oberfläche und eines
Pfades, der in diesem Fall die Sichtachse darstellt, durchgeführt. In ArcGIS können Sich-
barkeitsanalysen nur auf der Basis eines Rasters oder TINs durchgeführt werden. Das
schon bestehende Raster, das die Geländeoberfläche beschreibt, dient hierfür als Grund-
lage. Da bei diesem aber keine Höheninformationen der Vegetation vorhanden sind,
mussten sie aus dem Baumkataster entnommen werden. Anhand dieser Daten konnte
ein Raster erzeugt werden, das die Baumhöhen repräsentiert. Dieses Raster enthält nur
die absoluten Höhen der Bäume. Um die relative Höhe über NN der Bäume zu erhalten,
mussten die Höhenwerte des Geländes addiert werden.

Spatial Analyst Tools -> Math -> Plus

Mit den beiden Rastern als Basis konnte nun ein Pfad erzeugt werden, der die Sichtachse
darstellt. Die Standardfunktionen von ArcGIS waren an dieser Stelle dafür nur unzurei-
chend geeignet. Es wurde auf ein Tool für ArcGIS zurückgegriffen, das frei verfügbar ist.
Das Tool EZ Profiler4 in der Version 9.3 von Min-Lang Huang bietet die Möglichkeit, ein
Point-Shape zu erzeugen, das die Höhen der Raster übernimmt. Dazu wurde zunächst
mit Hilfe des Tools ein Anfangspunkt (Hermannsberg) und ein Endpunkt (Messegelän-
de) bestimmt. Dieses Tool erzeugt daraus eine vorher definierte Anzahl an regelmäßigen
aneinander gereihten Punkten. Es entstand ein Point-Shape mit 5.000 Stützpunkten.
Gleichzeitig erhielten die Punkte an den betreffenden Stellen die Höhen der beiden Ra-
ster. Da in dem Bereich des ’neuen’ Messegeländes die Höhen der Oberfläche in das

4http://arcscripts.esri.com/details.asp?dbid=12685 Besucht: 27.12.2007
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Point-Shape übernommen wurde, mussten diese Punkte manuell bearbeitet und auf ein
entsprechendes Niveau gebracht werden. Dafür wurden die vorher ermittelten Werte des
Messegeländes auf die Werte der Oberfläche addiert. Das Point-Shape ermöglichte es ein
Diagramm zu erstellen, das alle Höhen auf der Strecke im Profil darstellt. Es stellt die
Höhen des Geländes, der Vegetation und der Gebäude dar. (Abb. 6.18)

Abbildung 6.18: Der Graph der Sichtbarkeitsanalyse

Das Diagramm gab Aufschluss, ob das Messegebäude, unter aktuellen Gegebenheiten,
vom Hermannsberg sichtbar ist oder nicht. Ausschlaggebend sind dafür die Bäume und
deren Höhe. Es ist ersichtlich, dass die Bäume, die zwischen Hermannsberg und neu-
em Messegelände stehen, höher als die Sichtachse sind. Das lässt vermuten, dass unter
aktuellen Gegebenheiten das Gebäude nicht sichtbar wäre.

6.4.1.3 Anpassung des Messegebäudes

Um eine Veränderung der Sicht darzustellen, boten sich mehrere Möglichkeiten. Eine
Variante wäre gewesen, die Baumhöhen anzupassen. Dafür kämen in der Realität meh-
rere Umstände in Frage, die eine Veränderung der Vegetation verursachen könnten. Ein
Szenario wäre eine Absenkung des Grundwasserspiegels, der durch die Annäherung des
Tagebaus im Süden des Parks verursacht werden könnte. Ältere, weniger vitale Bäume
und Pflanzen könnten möglicherweise eingehen und absterben. Nur die Bäume, die ei-
ne sehr gute bis gute Vitalität hätten und nahe am Wasser stünden, blieben erhalten.
Dadurch würden sich teilweise dicht bewaldete Stellen lichten und gäben möglicherweise
eine Sicht auf das ’neue’ Messegebäude frei.

Ein weiteres Szenario wäre eine Dürre, bedingt durch einen Klimawandel. Auch hierbei
sind in erster Linie die selben Bäume betroffen. Analog zum ersten Szenario würden
weniger vitale Bäume absterben und eine Sicht auf das Messegebäude möglicherweise
freigeben. Dabei dürften die höchsten Bäume für beide Szenarien, die eine Sicht auf das
Messegebäude freigäben, nicht höher als 15 m sein.

Die Variante, die Höhe des Messegebäudes anzupassen, wurde dann auch für die
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VRML-Welt umgesetzt. Die Bäume wurden für diese ’Welt’ so belassen und gleichen
denen des aktuellen Modells. Auf der Abbildung 6.18 ist zu erkennen, welche Höhe das
Gebäude haben müsste, um vom Hermannsberg sichtbar zu sein. Die Höhe des höchsten
Baums auf der Sichtlinie ist dabei ausschlaggebend. Diese beträgt 30 m. Das heißt, dass
das ’neue’ Messegebäude, um sichtbar zu sein, mehr als doppelt so hoch sein müsste, wie
zuvor ermittelt wurde. Anhand des Polygon-Shapes, das den Standpunkt des Gebäudes
darstellt, konnte in ArcGIS daraus eine einfache Repräsentation erstellt werden. Dazu
wurde die Fläche des Gebäudes in die Höhe extrudiert. ArcGIS bietet dafür folgende
Möglichkeit:

ArcGIS -> Rechtsklick auf ’Properties’ -> Reiter ’Extrusion’

Die Höhe des nun entstandenen Kubus beträgt 30 m. Um ein erneutes Bearbeiten des
Geländes mit Maya zu umgehen, wurde als Grundlage für die VRML-Welt des fiktiven
Parks, das Modell des aktuellen Parks verwendet. Da die Koordinaten für VRML an-
hand aller in ArcScene geladenen Objekte bestimmt werden (Kap. 6.2.1.4), musste für
eine exakte Darstellung in VRML ein etwas umständlicher Weg gegangen werden. Da-
durch, dass das Messegebäude außerhalb des eigentlichen Parks steht, hat es durch den
Export einen räumlich falschen Standpunkt in Relation zum aktuellen Modell. Um das
auszugleichen, wurde das Gelände-TIN mit dem Messegebäude als eine Datei exportiert.

Nach dem Export in das VRML-Format und der Konvertierung in das Maya-ASCII-
Format konnte das Gebäude in dem Modell, mit Hilfe des Geländes als Referenz, an
der räumlich richtigen Stelle positioniert werden. Dazu wurden die beiden Objekte in
Maya als ein Objekt behandelt und so verschoben, dass das Gelände an der selben Stelle
des bereits richtig platzierten Geländes war. Somit erhielt auch das Messegebäude die
korrekte Position im Raum, und das zuletzt importierte Gelände konnte anschließend
gelöscht werden.

6.4.2 Einfügen einer Umgebungskarte

Für die Orientierung des Betrachters wurde in die fiktive VRML-Welt eine weiträumige
Karte eingefügt. Sie dient dazu, das umliegende Areal andeutungsweise darzustellen. Da
die Texturen nicht sehr detailliert sind, werden einzelne Objekte in der Landschaft nur
ungenau dargestellt. Der Detailgrad reicht dennoch für die VRML-Welt aus. Anhand der
Karte ist zu erkennen, an welcher Stelle im umliegenden Parkareal das ’neue’ Messege-
bäude steht. Die Karte wurde aus dem Programm Google Earth5 als JPEG entnommen
und anschließend in ArcGIS georeferenziert. Ebenso wie in Kapitel 6.4.1.3 musste für eine
räumlich korrekte Darstellung der Karte im VRML-Modell, das Gelände-TIN zusammen
mit dieser als eine Datei exportiert werden. Sie dient, wie auch beim Messegebäude, als
Referenz zur Positionierung der Karte in Maya. Die Karte wird als texturiertes, recht-
eckiges Polygon in Maya dargestellt.

5Google Earth ist eine frei verfügbare Software, die Satellitenbilder, Landkarten, Geländedaten und 3D-
Gebäude zu einem geografischen Informationssystem vereint. Quelle: http://earth.google.de/ Besucht:
20.11.2007
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7 Erzeugung der VRML-Welten

7.1 Zusammenfügen aller Objekte zu einer kompletten
VRML-Welt

Nachdem alle Objekte für die VRML-Darstellung in ArcGIS und Maya erzeugt wurden,
konnten diese zu einer ’Welt’ vereint werden. Alle Objekte, wie die Teile des Terrains,
die Gebäude und die Bäume, sind als einzelne VRML-Dateien vorhanden. Diese besit-
zen Information über die Geometrie, den Standpunkt und die Texturen der jeweiligen
Objekte. Sie wurden in einer Hauptdatei eingebunden und ergeben in ihrer Gesamtheit
die jeweilige VRML-Welt. Die Hauptdatei beinhaltet neben den eingebunden Objekten
Informationen über die Ausleuchtung der Szenerie, die Viewpoints und den Avatar.

Die Methodik, die im weiteren beschrieben wird, ist für alle VRML-Welten gleich. Es
weichen lediglich die einzelnen Objekte jeweils voneinander ab. Einzelne Objekte wurden
unterschiedlich eingebunden. Abhängig war das von der Art des Objekts. Es wurde
grundsätzlich in drei verschiedene Objekttypen für die VRML-Welten unterschieden:

• Gelände - dazu zählen das Terrain, das Wasser, die Pyramiden, die Inseln, der
Himmel und die Wege

• Gebäude - alle Häuser und Brücken als hoch- und niedrigpolygonale Objekte
sowie die Pergola, Wassertreppe, Torhaus, Gewächshaus, Mauern und das Parisol

• Bäume - alle Baumgruppen mit den jeweiligem Repräsentanten

7.1.1 Gelände

Diese Daten wurden direkt in die VRML-Welt geladen. Dabei wurden alle einzelnen
Objekte innerhalb eines Transform-Knotens in die Hauptdatei eingebunden. Innerhalb
des Transform-Knotens sind Inline-Knoten, die die eigentlichen Dateien laden. (Abb.
7.1)

7.1.2 Gebäude

Einige Gebäude haben zwei Repräsentanten, ein hochpolygonales und ein weniger geo-
metrieintensives Objekt. Diese Objekte, die zwei oder mehr Darstellungen haben, werden
nicht direkt in die VRML-Welt geladen, sondern innerhalb einer gesonderten Datei. Die-
se Datei definiert, mittels eines LOD-Knotens, ab welcher Distanz zum Avatar welche
Objekt-Darstellung geladen wird. (Abb. 7.2) Die LOD-Dateien für jedes Objekt werden
in der Hauptdatei in jeweils einem Transform-Knoten geladen. Denn anders als beim
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DEF Gelaende Transform {
t r a n s l a t i o n 0 0 0
r o t a t i o n 0 0 0 0

c h i l d r e n [
I n l i n e {

u r l ’ ’ geometr ie / l a nd s cha f t / land . wrl ’ ’
}

I n l i n e {
u r l ’ ’ geometr ie / l a nd s cha f t /wege . wrl ’ ’

}
.
.
.
]

}

Abbildung 7.1: Auszug aus der VRML-Hauptdatei

Gelände sind immer nur einige Objekte im Sichtfeld und müssen somit auch nur einzeln
vom Browser gerendert werden. (Kap. 4.2)

7.1.3 Bäume

Die Bäume des virtuellen Parks sind zu Baumgruppen des selben Typs mit gleicher
Höhe zusammengefasst. Eine Baumgruppe wird von einem Repräsentanten dargestellt.
(Kap. 6.2.4.1) Die Bäume sollen als Billboards eingebunden werden, die abhängig vom
Betrachter immer mit ihrer Front sichtbar sind. Weiterhin sollen einzelne Bäume, die
weiter als ein definierter Wert vom Betrachter entfernt sind, ausgeblendet werden. In der
Hauptdatei wird hier zunächst eine ’Transform-Datei’ geladen. Diese Datei beinhaltet alle
Standpunkte der Bäume einer Baumgruppe. Innerhalb dieser Datei sind alle Standpunkte
mit dem ’Group’-Knoten zusammengefasst. Der erste Standpunkt ist ein Transform-
Knoten, der den ’Prototyp’ definiert. Der Transform-Knoten beschreibt die Position
eines Standpunkts im Koordinatenursprung und lädt eine LOD-Datei, die bestimmt, ab
welcher Entfernung vom Betrachter dieser sichtbar ist. Der Prototyp wird dann so oft
instanziert, wie Bäume in einer Gruppe sind. Die LOD-Datei beinhaltet einen Inline-
Knoten, der schließlich das eigentliche Baum-Modell lädt. (Abb. 7.3)
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#VRML V2. 0 ut f8
DEF LOD kavaliershaus Transform {
t r a n s l a t i o n 0 0 0
r o t a t i o n 0 0 0 0

c h i l d r e n [
Group {

c h i l d r e n [
LOD {

range [ 2 0 0 ]
l e v e l [
DEF LOD 1 Group {

c h i l d r e n [
DEF k a v a l i e r s h a u s Transform {

t r a n s l a t i o n 0 0 0
c h i l d r e n [

I n l i n e { u r l ’ ’ Kava l i e r shaus . wrl ’ ’ }
]

}
]
}

DEF LOD 2 Group {
c h i l d r e n [
DEF kava l i e r shaus1 Transform {

t r a n s l a t i o n 0 0 0
c h i l d r e n [

I n l i n e { u r l ’ ’ Kava l i e r shaus lowPoly . wrl ’ ’ }
]

}
]

}
]

}
]

}
]

}

Abbildung 7.2: LOD-Datei des Kavaliershauses
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#VRML V2. 0 ut f8
DEF LOD baum Transform {
t r a n s l a t i o n 0 0 0

c h i l d r e n [
DEF LOD baum1 Transform {

t r a n s l a t i o n 0 0 0
c h i l d r e n [

I n l i n e { u r l ”LOD eiche s i chtachse berg 20 24 . wrl ”}
]

}
Transform {

t r a n s l a t i o n −205.500000 74.400002 306.999984
c h i l d r e n USE LOD baum1
}

Transform {
t r a n s l a t i o n −237.500000 86.939995 288.999984
c h i l d r e n USE LOD baum1
}

.

.

.
]

}

Abbildung 7.3: Auszug einer Transform-Datei
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7.2 Viewpoints

Die Sichten sind für alle VRML-Welten von großer Bedeutung. Deshalb wurde viel Wert
auf die Genauigkeit dieser gelegt. Um die Sichten in der VRML-Welt zu erzeugen, bedurf-
te es jeweils zweier Punkte: Eines Ausgangspunkts und eines Zielpunkts. Diese Punkte
wurden in ArcGIS erzeugt, um eine räumlich korrekte Position zu den anderen Objek-
ten zu gewährleisten. Nach dem Export in das VRML-Format wurden sie benutzt, um
die Sichten zu erzeugen. VRML hat dafür den Viewpoint-Knoten. Der Knoten definiert
die Postion des Betrachters als Punkt und die Blickrichtung als Vektor. Die Blickrich-
tung oder auch ’Orientation’ wird als Drehung des Vektors um eine Achse angegeben.
Die ersten drei Werte definieren dabei den Vektor der Drehachse vom aktuellen Ko-
ordinatenursprung aus, der vierte Wert ist der Drehwinkel im Bogenmaß. Da nur die
Positionen bekannt waren, musste die Blickrichtung aus den zwei Punkten berechnet
werden. Das Programm ’VRML Viewpoints’ 1 von Robert Walker wurde verwendet, da
es diese Funktionalität bereitstellt. Die Anwendung ist frei verfügbar. Nach der Berech-
nung der Blickrichtung wurden die Viewpoint-Knoten in die Hauptdatei eingebunden.
Der VRML-Browser bietet dann die Möglichkeit, zwischen den einzelnen Viewpoints
auszuwählen. Je nach Auswahl wird der Avatar auf diesem Punkt platziert.

1http://www.robertinventor.com/virtualflower/vv/index.htm Besucht: 22.11.07
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8 Auswertung

8.1 Genauigkeit und Realitätsnähe der Modelle

8.1.1 Das aktuelle und das fiktive Modell

Der größte Teil des Prozesses der Erstellung der relevanten Daten für die VRML-Welt
geschah in ArcGIS. Dadurch konnte gewährleistet werden, dass die Objekte zueinander
eine exakte Relation haben. Das heißt, dass auch in der fertigen Welt alle Objekte richtig
arrangiert sind. Dabei sei jedoch erwähnt, dass das VRML-Modell das Original nur als
vereinfachte Version darstellt. Im gesamten Prozess wurden Objekte, wie beispielsweise
das Gelände, von einem sehr konkreten Modell in ein abstraktes überführt, und einzelne
Objekte, wie die Pyramiden und die Inseln, im Nachhinein neu erzeugt. Dadurch gingen
kleinteilige Strukturen teilweise verloren. Vor allem bei der Bearbeitung des Geländes
war das der Fall. Verantwortlich dafür waren die jeweiligen Prozesse der Vereinfachung,
die eine adäquate Darstellung für VRML gewährleisten sollten. Faktoren, die die Genau-
igkeit der VRML-Welt des aktuellen Zustands beeinträchtigt haben, werden im weiteren
angeführt. Da die Daten der aktuellen Welt auch die Grundlage für die VRML-Welt des
fiktiven Szenarios bilden, gelten die selben Faktoren auch für diese VRML-Welt.

Nachbearbeitung des Geländes in ArcGIS

Durch die Fehldarstellung der Bereiche des Wassers und der Brücken mussten betref-
fende Stellen durch selbst erzeugte Daten bearbeitet werden. Die Defizite des Modells
wurden mit einem Polygon-Shape bearbeitet, das an allen Stellen die selbe Höhe aufwies.
Somit konnten Wassergrund und Uferkanten an allen Stellen auf ein einheitliches Niveau
gebracht werden, was im realen Park nicht der Fall ist. Die Inseln und die beiden Py-
ramiden mussten durch den Schritt der Nachbearbeitung des Wasserareals neu erzeugt
werden. Diese bestanden nach der Erstellung aus sehr vereinfachten geometrischen Ob-
jekten. Das machte sie mitunter kantig, was in der Realität so auch nicht der Fall ist.
Durch die Vereinfachung des Geländes wurde aus mehreren aneinander liegenden Po-
lygonen innerhalb eines Toleranzbereichs ein generalisiertes Polygon erzeugt. Dadurch
gingen natürliche Geländeunebenheiten verloren. Mit der Wahl eines Toleranzbereichs
von 10 cm sind Geländemerkmale, wie kleine Hügel oder Vertiefungen, die unter diesem
Toleranzbereich lagen, geglättet worden.
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Vereinfachung des Geländes in Maya

Maya wurde hauptsächlich dafür eingesetzt, das Gelände weiter zu vereinfachen und
die GIS-Daten mit den Gebäuden zu einer Welt zu kombinieren. Ähnlich wie bei der
Nachbearbeitung in ArcGIS wurde das Gelände, das sich aus dem Terrain und den her-
ausgelösten Wegen zusammensetzt, weiter vereinfacht. Dadurch gingen auch hier klein-
teilige Strukturen verloren. Um die ’kantigen’ Darstellungen des Geländes und der Wege
auszugleichen, die durch den Prozess der Vereinfachung entstanden, wurden die Norma-
lenvektoren modifiziert. Das jedoch beeinflusste die Konturen des Geländes nachteilig.
Das Gelände behielt zwar markante Höhenunterschiede, wie die größeren Hügel oder die
Kanäle, aber einzelne Bereiche im Park wurden dadurch generalisiert.

Gebäude

Durch den Export der Standpunkte anhand der CAD-Karte aus ArcGIS besitzen die
Gebäude auch die exakte Position im Modell. Die Gebäude wurden, wenn sie nicht
schon vorhanden waren, als geometrisch einfache Objekte erstellt. Sie sind vereinfachte
Versionen und wurden anhand von Bildern erstellt. Sie sind in Form und Aussehen mit
den Originalen vereinbar, weisen jedoch weniger Details als diese auf. Für eine Darstel-
lung im VRML-Modell sind sie ausreichend.

Bäume

Für die Darstellung in VRML wurden die Baumstandpunkte aus ArcGIS übernommen
und sind daher ebenso präzise wie die Standpunkte der Gebäude. Die einzelnen Bäume
sind jedoch nur vereinfacht dargestellt, und ein Baummodell repräsentiert hunderte von
Bäumen. Da sich das Modell nur auf repräsentative Baumarten mit einer bestimmten
Höhe beschränkt, spiegelt es nicht die ganze Vielfalt des realen Parks wieder. Deswei-
teren sind in dem Modell nur die Bäume vorhanden, die in einer der beiden Sichten
involviert sind. Dadurch können bei der Navigation durch das Modell Sichten entstehen,
die mit dem realen Abbild keinesfalls übereinstimmen. Die Darstellung eines Baums ist
auf eine Ansicht von vorn beschränkt. Der Baum hat somit immer die selbe Erscheinung,
gleich aus welcher Richtung dieser betrachtet wird. Die Komplexität der Vegetation des
realen Parks konnte im Modell nicht realisiert werden, jedoch ist von den Sichtpunkten
der visuelle Eindruck mit dem Original gut vereinbar.

8.1.2 Das historische Modell

Beim Modell des historischen Parks gab es kaum Material, das eine exakte Nachbildung
zuließ. Orientierung boten das vorhandene GIS-Material und die Beschreibungen Ettrichs
[5]. Dabei ist der Datenbestand nur auf die Fließ- und Standgewässer, den Standpunkt
der Häuser sowie der Verkehrswege innerhalb des ausgewählten Bereichs beschränkt. Ge-
ländedaten, die die Beschaffenheit der Oberfläche beschreiben, waren nicht vorhanden.
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Auch gab es kaum Bildmaterial, auf dem das Areal, die Gebäude und die Vegetation
sichtbar waren. Es ist somit schwer, Aussagen über die Genauigkeit und die Realitäts-
nähe des Modells zu treffen, da keine Referenz vorhanden ist. Da das Modell nur eine
Variante darstellt, wie es 1845 hätte aussehen können, sollen im folgenden die einzelnen
Objekte der VRML-Welt diskutiert werden, die darin eingeflossen sind:

Gelände

Bei der Erstellung des Geländes wurden die selben Daten verwendet, die dem Modell
des aktuellen Zustands zugrunde lagen. Die Geländedaten wurden anhand der Beschrei-
bungen Ettrichs [5] modifiziert. Kanäle und Erhebungen wurden mit selbst erzeugten
Daten aus dem Gelände herausgearbeitet, so dass ein ebenes Terrain entstand, das mit
den Aufzeichnungen vereinbar ist. Dabei wurde von der Geländehöhe des aktuellen Mo-
dells ausgegangen. Es wäre möglich, dass um 1845 dieser Bereich eine andere Höhe oder
Beschaffenheit aufwies. Anhand vom GIS-bezogenen Material des Branitzer Parks, das
Aspekte des Areals um 1845 beschreibt, wurden diese in das Gelände eingearbeitet. In-
wiefern das GIS-bezogene Material, das den Park um 1845 beschreibt, korrekt ist, konnte
nicht bewertet werden. Auch bei der Höhe der Gewässer wurde von den selben Höhen
ausgegangen, die auch im aktuellen Modell benutzt wurden. Möglich ist es auch hier,
dass diese von den heutigen abwichen.

Gebäude

Die Standpunkte der Gebäude für das VRML-Modell sind ebenfalls dem GIS-Material
entnommen. Über Aussehen, Größe und Form gab es keinerlei Aufzeichnungen. Die einzi-
ge Ausnahme war das Schloss und die nähere Umgebung. Hier lag eine Graphitzeichnung
vor. Nach diesem Bild wurde das bestehende Modell des Schlosses verändert und ange-
passt. Inwiefern das Bild mit dem damaliegen Original übereinstimmt, ließ sich nicht
bestimmen. Es können somit keine Aussagen auf absolute Korrektheit getroffen werden.
Es kann jedoch davon ausgegangen werden, dass das Modell dem realen Schloss um
1845 annähernd entspricht, da die schriftlichen Aufzeichnungen damit konform gehen.
Die Erstellung der restlichen Gebäude, wie der Häuser um den heutigen Schwarzen See,
orientierte sich daher größtenteils am VRML-Modell der Cottbuser Altstadt um 1720.
Die Formen der Häuser wurden aus diesem übernommen und in Maya nachgebildet. Die
ausgewählten Texturen lassen sich mit den Häuserdarstellungen, die von Ettrich [5] be-
schrieben sind, vereinbaren. Die Modelle der Häuser stellen nur eine Annäherung dar.
Ob sie mit den Originalen von 1845 identisch sind, konnte nicht bestimmt werden.

Bäume

Die Positionen der Bäume wurden überwiegend willkürlich ausgewählt, da kein Material
vorhanden war, das diese exakt bestimmte. Sicher ist, dass es überwiegend Nadelbäume
waren. Das geht aus den Beschreibungen Ettrichs [5] und der Graphitzeichnung Massers
hervor. Anhand der beiden Aufzeichnungen wurden die Bäume unter Berücksichtigung
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der Gebäude, der Gewässer und der Wege sporadisch im Modell platziert. Es besteht
keine Möglichkeit, dieses auf Korrektheit und Realitätsnähe zu überprüfen.

8.2 Performance der fertigen VRML-Welten

Die Performance der einzelnen Welten hängt von mehreren Faktoren ab. Dabei spielt die
zugrunde liegende Hardware in Bezug auf die Ladezeiten und die flüssige Darstellung
der Welten eine große Rolle. Wieterhin beeinflusst die Datengröße der Welten die Perfor-
mance. Die VRML-Welt des aktuellen Parks, sowie die des Zukunftsszenarios hat jeweils
mit allen Objekten und Texturen eine Größe von ca. 20 MB1. Die Welt des historischen
Parks hat eine Größe von ca. 12 MB. Für eine Internetpräsentation bedarf es deshalb
einer schnellen Verbindung, um die Welten innerhalb einer angemessenen Zeitspanne zu
laden. In Bezug auf Kapitel 4.2 wurden folgende Beobachtungen gemacht:

Strukturierung der Modelle

Es hat sich gezeigt, dass die Zusammenführung einzelner IndexedFaceSets zu einem
Ganzen einen Leistungsgewinn begünstigt. Vor allem bei den 15 Brücken, deren Gelän-
der teilweise aus einer Vielzahl an geometrischen Objekten bestehen, ist ein Unterschied
hinsichtlich der Ladezeit und der flüssigen Darstellung bemerkbar. Das Backface Culling
war in jeder von ArcGIS und Maya exportierten VRML-Datei bereits aktiviert. Hier
wurde kein Vergleich vorgenommen.

Szenen-Komplexität

Einige Objekte im virtuellen Park sind durch zwei Darstellungen realisiert. Nähert sich
der Avatar so einem Objekt, wird ab einer definierten Distanz eine wesentlich detaillier-
tere Version geladen. Das heißt, komplexere Geometrie sowie eine größere Anzahl von
Texturen ersetzen dann das vereinfachte Objekt. Es treten Zwischenladezeiten beim Na-
vigieren durch die Szene auf, welche das Bild kurzzeitig ’einfrieren’ lassen. Vor allem bei
den Gebäuden wie dem Schloss, dem Marstall und dem Kavaliershaus ist dieses deut-
lich bemerkbar. Bei den Bäumen im Modell ist dieser Effekt, aufgrund ihrer einfachen
Darstellung, nicht feststellbar. Sie werden ab einer gewissen Entfernung zum Betrachter
ausgeblendet und beim Annähern erneut eingeblendet, ohne die Qualität der Darstellung
zu mindern.

Räumliche Organisation

Das Gelände wurde nicht, wie in Kapitel 4.2 beschrieben, in einzelne Cluster unter-
teilt, da nicht nur ein kleiner Teil, sondern mitunter das komplette Terrain sichtbar ist.
Weiterhin wirkt sich die Separierung einzelner Objekte kaum auf die Performance aus.
Es spielt für alle VRML-Welten keine Rolle, ob räumlich separierte Objekte in VRML

1Megabyte
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gruppiert, beziehungsweise im selben Transform-Knoten arrangiert sind oder nicht. Das
gilt für die Gebäude, die Bäume, sowie für das Gelände.

Instanzierung

Ein signifikanter Unterschied der Ladezeit und der Darstellung der VRML-Welt konn-
te bei der Instanzierung der Bäume festgestellt werden. Verglichen wurden dabei alle
Bäume, die in die Sicht vom Hermannsberg involviert sind. Ist jeder Baum einzeln mit
’DEF’ definiert, dauert das Laden erheblich länger, als würden diese nur einmal definiert
und anschließend mit ’USE’ instanziert. Da in dieser Sicht mehr als 400 einzelne Bäume
dargestellt werden, macht sich ein Leistungsgewinn deutlich bemerkbar. Die Texturen
müssen jeweils nur einmal für eine Baumgruppe geladen werden.

Texturen oder Polygone

Im Gegensatz zu den Anführungen in Kapitel 4.2 wurde festgestellt, dass Texturen an
Stelle von Polygonen keinen Leistungszuwachs bringen. Es wurde vielmehr beobachtet,
dass Texturen erheblich längere Ladezeiten verursachen als komplexe Polygone. Vor al-
lem bei dem Modell, das den historischen Park darstellt, ist dieser Effekt sehr deutlich.
Das ist durch die Vielzahl an Häusern und deren Texturen zu begründen. In diesem
Modell befinden sich 35 Häuser, die alle komplett texturiert sind. Ist die VRML-Welt
jedoch einmal geladen, treten keine weiteren Ladezeiten mehr auf und die Navigation
durch die Welt ist flüssig.

8.3 Nutzbarkeit von ArcGIS im Vergleich zu anderen
Methoden

Andere GIS-Software

Es gibt neben ArcGIS viele andere GIS-Programme. Diese teilen sich in die lizenpflich-
tigen und die frei verfügbaren. Dabei wurde festgestellt, dass GIS-Freeware in ihrer
Funktionalität auf bestimmte GIS-Aspekte spezialisiert ist. Einige dieser bieten nur die
Möglichkeit, die Daten zu visualisieren, jedoch kaum Operationen auf Datensätzen, wie
es bei ArcGIS möglich ist. Auch der Austausch von Datensätzen und die Im-/Export-
Möglichkeiten waren für diese Arbeit unzureichend. Es konnten keine anderen lizenz-
pflichtigen Programme im gleichen Umfang untersucht werden, da diese als Testversio-
nen angeboten werden und deshalb nur eingeschränkte Funktionalitäten besitzen.
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Weitere Möglichkeiten

Neben der Bearbeitung der Rohdaten der Überfliegung in ArcGIS gibt es noch wei-
tere Möglichkeiten, ein Modell aus diesen zu erzeugen. 3ds Max2 der Firma Autodesk
bietet die Möglichkeit, die Geländedaten aus den ASCII-Dateien direkt einzulesen und
daraus ein Geländemodell zu erzeugen. Beim Import wird allerdings die Geometrie vorab
vereinfacht, was für die Arbeit nicht erwünscht war. Um das Gelände weiter zu bear-
beiten, müssen Stützpunkte einzeln manipuliert werden. Dies kann bei der Größe der
Daten mitunter sehr zeitaufwändig sein, und es besteht keine Referenz, an der sich ori-
entiert werden kann. Die Resultate können somit vom Original stark abweichen, und
die räumliche Korrektheit kann in einem 3D-Modeller kaum gewährleistet werden. Des-
weiteren wurde festgestellt, dass diese Methode große Ansprüche an die Hardware des
Computers stellt. Bei den Datenmengen ist es nötig, genügend Arbeitsspeicher zu haben.
Die Erzeugung eines Geländemodells im 3D-Modeller kann auch auf eine manuelle Art
erfolgen. Anhand der CAD-Karte ist es möglich, das Gelände ’nachzubauen’. Die Karte
wird in den Hintergrund projiziert, und aufgrund der Geländelinien kann ein Modell er-
zeugt werden. Dabei müssen die Höhen den einzelnen Stützpunkten manuell zugewiesen
werden. Diese Methode wurde für die schon bestehenden VRML-Welten der Bereiche
des Branitzer Parks angewendet und ist sehr zeitaufwändig. Sie führt auch zu weniger
genauen Ergebnissen.

ArcGIS

Die einzelnen ArcGIS–Module haben den gleichen benutzerfreundlichen Aufbau. Das
macht sie nach einer Eingewöhnung gut bedienbar. Lediglich die Toolbox ist auch nach
einer Eingewöhnung noch schwer überschaubar, da diese eine Vielzahl an Funktionen
bietet. Durch die Suchoptionen innerhalb der Toolbox ist es aber möglich, die jeweils
entsprechende Funktion zu finden, die auf einen Datensatz angewendet werden soll.
Das Programm bietet einen guten Support, einerseits durch die Hilfe in ArcGIS und
andererseits durch den Internetsupport. Im Internet stehen viele Tools bereit, die die
Funktionalitäten von ArcGIS ergänzen. Diese sind meist von Anwendern der GIS-Reihe
programmiert und auf der Support-Seite von ArcGIS frei verfügbar. Weiterhin bietet
ArcGIS viele Im-/Export-Möglichkeiten für verschiedene Dateiformate.

Die Arbeit mit ArcGIS, zur Erstellung der VRML-Welten, gestaltete sich anfangs
recht umständlich. Durch die Komplexität und Funktionsvielfalt dieses Programms ist
eine Einarbeitungszeit sehr langwierig. Sind aber die Grundlagen verstanden und ist
ein Verständnis für die Arbeitsweise des Programms geschaffen, ist es mit Abstand die
effektivste Methode im Vergleich zu den anderen beschriebenen Methoden, die vorhan-
denen Daten zu bearbeiten. Räumliche Korrektheit und eine realitätsnahe Darstellung
sind zweifelsfrei die Aspekte, die ArcGIS von den anderen Methoden abheben. Ist man

23ds Max ist ein 3D-Computergrafik- und Animationsprogramm. Es kommt in den Bereichen Anima-
tion, Film, Design und Architektur zur Anwendung.
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mit dem Programm vertraut, ist der Workflow erheblich effektiver, verglichen mit der
Erstellung der ’Welten’ im 3D-Modeller. Dabei ist besonders zu erwähnen, dass aufgrund
des vorhandenen Materials ArcGIS prädestiniert war. Hätten keine Geländedaten vor-
gelegen, wäre ArcGIS zur Erstellung des Modells weniger effektiv gewesen. Weiterhin ist
zu sagen, dass unterschiedliche Ausgangsdaten auch unterschiedliche Herangehensweisen
verlangen. So ist die Methodik, die in der Arbeit beschrieben wurde, nicht zwangsläufig
auf andere Projekte übertragbar. Sie stellt vielmehr eine Variante dar, mit der Daten für
eine VRML-Darstellung aufgearbeitet werden können. Zusammenfassend lässt sich fest-
halten, dass ArcGIS den geforderten Anforderung entsprach. Seine Vielfältigkeit machte
es zu einem sehr nützlichen Werkzeug für diese Arbeit.

8.4 Ausblick & Schlussfolgerungen

Alle Daten, die zur Erzeugung der Modelle erstellt wurden, können für weiterführende
Arbeiten genutzt werden. Dabei ist es möglich, die GIS-bezogenen Daten, die Maya-
Daten und die VRML-Daten zu nutzen und auf sie aufzubauen.

• Mit den GIS-Daten ist es möglich, weitere Sichtbarkeitsanalysen zu erstellen. Somit
können die Sichten, die Pückler geplant hatte, im Vorfeld darauf untersucht werden,
welche Gegebenheiten nötig wären, um diese wiederherzustellen, beziehungsweise
beizubehalten.

• Es können in ArcGIS Modelle erzeugt werden, die die Annäherung des Tagebaus
im Süden untersuchen und die damit verbundene Veränderung des Grundwasser-
spiegels darstellen. Auch Untersuchungen, die die Hydrologie betreffen, sind mach-
bar. Die Auswirkungen eines Klimawandels wären analysierbar. Dabei können die
Bäume und die Gewässer mit einbezogen werden, um zu ermitteln, wie der Park
sich wandeln würde, wenn bestimmte klimatische Faktoren sich ändern oder Über-
schwemmungen beziehungsweise Dürreperioden aufträten.

• ArcScene bietet neben den Möglichkeiten der Bearbeitung, der Betrachtung und
des Exports dreidimensionaler Daten, auch die Option Animationen zu erzeugen.
Es können Kameraflüge über die Landschaft simuliert werden. Das Video kann
anschließend als AVI3-Datei exportiert werden und in jeder Abspielsoftware, das
das AVI-Format unterstützt, wiedergegeben werden.

• Shape-Files können in ein für Google Earth kompatibles Format exportiert wer-
den. Damit kann der Park auch in Google Earth dargestellt werden. Dazu bietet
ArcGIS die Exportfunktion in das KML4-Dateiformat. Exportiert werden können
Line-, Point- und Polygon-Shapes. Um die Geländeoberfläche in Google Earth dar-
zustellen, muss das TIN in eines dieser Shapes umgewandelt werden. Die Toolbox
bietet dafür mehrere Funktionen.

3Audio Video Interleaved ist ein Videoformat
4Keyhole Markup Language ist ein Dateiformat für das Programm Google Earth
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Darüberhinaus ist es auch möglich, die Geländedaten aus Maya zu exportieren.
Dafür bedarf es eines zusätzlichen Programms für Maya. Das Porgramm Maya
2 Google Earth5 der Firma Eyebeam ist kostenlos verfügbar und ermöglicht den
Export in das KML-Format. Für den Export ist es notwendig, die Koordinaten des
zu exportierenden Objekts in der realen Welt zu kennen. Auch Gebäude können
aus Maya für Google Earth exportiert werden.

• Aufgrund der Detailiertheit des Baumkatasters, das Informationen über jeden
Baum beinhaltet, wäre es möglich, das Parkmodell vom aktuellen Zustand um
weitere Bäume zu erweitern. Es könnte die Vielfalt der Vegetation für ein virtu-
elles Modell differenzierter dargestellt und der Baumbestand auf den kompletten
virtuellen Park erweitert werden. Auch die Baumdarstellung kann durch komple-
xere Modelle repräsentiert werden.

• Aus den vorhandenen Daten können weitere VRML-Welten erzeugt werden, die
verschiedene andere Szenarien zeigen, so zum Beispiel: eines mit einer Sicht auf die
Cottbuser Altstadt im historischen Modell oder eines mit einer Sicht auf Windräder
im Osten des Parks für das fiktive Modell. Desweiteren wäre es möglich, den Park
zu verschiedenen Jahreszeiten darzustellen. Die einzelnen Parkmodelle könnten so
modifiziert werden, dass sie den Branitzer Park im Herbst oder Winter darstellen.
Dafür müssten lediglich die Texturen der Landschaft und der Bäume verändert und
angepasst werden. Den VRML-Welten können weitere Attribute wie Musik und
Geräusche oder interaktive Elemente, die einzelne Objekte des Parks beschreiben,
hinzugefügt werden.

In einer virtuellen Welt können Situationen dargestellt werden, die in der Realität
nicht existieren. Der virtuellen Welt sind keine gestalterischen Grenzen gesetzt. So sind
beispielsweise eine Reise durch die Zeit und Interaktionen mit Objekten vorstellbar. Für
den Betrachter ist es möglich, jeden beliebigen Betrachtungsstandpunkt in der VRML-
Welt einnehmen. Daraus können umfassende visuelle Analysen durchgeführt werden.
Diese Aspekte wären bei einer Visualisierung als Video oder Bild nicht zufriedenstellend
umsetzbar.

Die fertigen VRML-Welten vermitteln innerhalb der definierten Sichten einen räumli-
chen Eindruck, der dem Original sehr nahe kommt. Die erwähnten Defizite in Hinsicht
auf die Vielfalt der Vegetation, die im Modell so nicht dargestellt werden konnte, und
die vereinfachte Darstellung des Geländes sind für die VRML-Welten jedoch nicht be-
sonders ausschlaggebend. Die Sichten im virtuellen Park sind am Original orientiert und
können mit dem realen Park gut in Verbindung gebracht werden. Vergleiche zwischen
den einzelnen Modellen können einen Eindruck darüber geben, was Veränderungen in-
nerhalb und außerhalb des Parks für eine Sicht bewirken. Sie stellen eine gute optische
Analysemöglichkeit dar, die sich stark an der Realität orientiert.

5http://production.eyebeam.org/tools/maya2google/ Besucht: 14.01.2008
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9 Anhang

Auf der beigelegten DVD sind folgende Daten enthalten:

Ordner GIS

• Ordner Heute – Alle in ArcGIS erzeugten Dateien für das aktuelle und das fiktive
Modell

• Ordner 1845 – Alle in ArcGIS erzeugten Dateien für das historische Modell

Ordner Maya

• Ordner Heute – Alle Objekte, die in Maya zum aktuellen und fiktiven Modell
gehören

• Ordner 1845 – Alle Objekte, die in Maya zum historischen Modell gehören

Ordner VRML

• Ordner Heute

– init.wrl – Hauptdatei, die die VRML-Welt lädt

– Ordner texturen – Texturen der Gebäude und der Bäume im JPEG–Format

– Ordner geometrie

∗ Ordner gebäude – WRL-Dateien aller Gebäude

∗ Ordner landschaft – WRL-Dateien des Geländes

∗ Ordner sky – WRL-Datei des Himmels

∗ Ordner vegetation – WRL-Dateien der Bäume

• Ordner 1845

– init.wrl – Hauptdatei, die die VRML-Welt lädt

– Ordner texturen – Texturen der Gebäude und der Bäume im JPEG–Format

∗ Ordner Häuser – Texturen der Häuser im JPEG–Format

– Ordner geometrie

∗ Ordner gebäude – WRL-Dateien aller Gebäude

∗ Ordner landschaft – WRL-Dateien des Geländes

∗ Ordner sky – WRL-Datei des Himmels
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∗ Ordner vegetation – WRL-Dateien der Bäume

• Ordner Szenario

– init.wrl – Hauptdatei, die die VRML-Welt lädt

– Ordner texturen – Texturen der Gebäude und der Bäume im JPEG–Format

– Ordner geometrie

∗ Ordner gebäude – WRL-Dateien aller Gebäude

∗ Ordner landschaft – WRL-Dateien des Geländes

∗ Ordner sky – WRL-Datei des Himmels

∗ Ordner vegetation – WRL-Dateien der Bäume

Ordner Ausarbeitung

• Bachelorarbeit.pdf
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